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Chapter 1: Getting Started

Overview

The CourseBuilder extension for Adobe Dreamweaver allows you to create Web-based learning interactions in a visual 

authoring environment. The CourseBuilder extension includes a set of easy to use templates and tools that simplify 

and accelerate the development of online learning content. Learning interactions created with the extension are fully 

Web-native, enabling cross-platform and cross-browser delivery without plug-ins or applets. 

Release Highlights

CourseBuilder extension for Adobe Dreamweaver on Mac OS

You can use the CourseBuilder extension for Adobe Dreamweaver on Mac environment. All features that are 

supported on Windows are available on Mac OS.

Support for Safari browser

In addition to other popular browsers, CourseBuilder extension for Adobe Dreamweaver supports Safari browser for 

both Windows and Macintosh.

The following table provides specific details of the supported browsers:

What you can do with CourseBuilder for Dreamweaver

CourseBuilder for Dreamweaver helps you quickly design compelling learning interactions with step-by-step 

assistance. In minutes, you can:

• Create true/false, multiple-choice, and all-that-apply quizzes

See “Multiple-Choice CourseBuilder Interactions” on page 28 for details.

• Create drag-and-drop matching exercises

See “Drag-and-Drop CourseBuilder Interactions” on page 34 for details.

• Create matching interactions

See “Matching Interactions” on page 44 for details.

• Create sequence interactions

See “Sequence Interactions” on page 47 for details.

Browser Platform Versions

Internet Explorer Windows 6, 7, and 8

Mozilla Firefox Windows and Mac OS 3.0 and 3.5

Safari Windows and Mac OS 4
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• Create explore interactions

See “Explore CourseBuilder Interactions” on page 50 for details.

• Create text-entry interactions

See “Text Entry CourseBuilder Interactions” on page 55 for details.

• Create Likert interactions

See “Likert Interactions” on page 60 for details.

• Create buttons, timers, and sliders

See “CourseBuilder Interaction Controls” on page 71 for details.

• Track user performance

See “Scoring and Data Tracking” on page 109 for details.

The extension lets you define a complete Web-based learning interaction. Choose which type of interaction you want 

to create from the “CourseBuilder Interaction Gallery” on page 26. You can edit the content of a CourseBuilder 

Interaction, so you do not have to start from scratch to make changes. You can extend the CourseBuilder Interaction's 

built-in functionality by creating your own interaction templates.

CourseBuilder for Dreamweaver includes both traditional learning interactions (multiple choice, drag and drop, 

explore, and text entry) and learning interactions that function much like desktop controls (buttons, timers, and 

sliders). You can combine CourseBuilder Interactions—for example, you can include a timer object with a drag-and-

drop object that records how long the user takes to complete the drag-and-drop interaction. You can use an Action 

Manager CourseBuilder Interaction to control conditions and actions for any or all other CourseBuilder Interactions 

on the page.

Learning CourseBuilder for Adobe Dreamweaver

The CourseBuilder for Dreamweaver package contains a variety of resources to help you learn the program quickly 

and become proficient in creating your own Web page interactions.

CourseBuilder for Dreamweaver Help

The CourseBuilder for Dreamweaver Help provides comprehensive information about all CourseBuilder Interaction 

features. 

CourseBuilder tutorials

The CourseBuilder tutorials show how to use CourseBuilder for Adobe Dreamweaver to create learning interactions. 

For more information, see “Dreamweaver Tutorials” on page 3.
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Chapter 2: Dreamweaver Tutorials

Tutorial overview

 This tutorial shows you how to use CourseBuilder for Adobe Dreamweaver to create many types of learning 

interactions. 

As you develop a web-based sales training module for sales representatives of Discovertoys.com, a fictitious company, 

you'll create:

• An explore interaction (where a user clicks areas on a page to gain more information about an object)

• A multiple-choice interaction (where a user selects a correct response from a set of choices)

• A drag-and-drop interaction (where a user demonstrates knowledge by dragging one object on the screen to 

another object on the screen).

Along the way, you'll learn how to perform the following tasks:

• Copy support files to a local site folder 

• Insert CourseBuilder Interactions in a document 

• Use the CourseBuilder Interaction dialog box to select an interaction template

• Customize CourseBuilder Interaction templates

• Use the Action Manager to attach actions to an interaction

• Edit CourseBuilder Interactions

• Test an interaction

Preview the completed Discover Toys interaction

Look at the completed CourseBuilder for Dreamweaver files to get an idea of what you're working toward. In the folder 

in which you installed CourseBuilder for Dreamweaver, open the folder named cb_tutorial. Then locate the folder 

named discover_comp, and double-click the file named discover_nav.htm.

The discover_nav page opens in your browser, click the buttons on this page to navigate to other pages of the site.

Try all of the possible combinations of correct and incorrect responses on the quiz pages to see how the interactions 

work. Click Refresh or Reload in the browser to restart an interaction.

Close the browser when you're finished looking at the files.

How the tutorial files are arranged

The cb_tutorial folder contains both the completed and partially completed HTML files used in this tutorial. 

The completed files are in the discover_comp folder. Images and other associated files for the completed files are in 

folders within the discover_comp folder. The partially completed files�which you'll be working on—are in the 

cb_discover folder. (The complete path to the discover_comp folder will vary, depending on where you have 

CourseBuilder for Dreamweaver installed.)
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Each file has a meaningful name for example, the HTML file for the completed module's navigation page is named 

discover_nav.htm.The partially completed files have names similar to their counterparts in the complete site, except 

they begin with cb_; the partially completed version of discover_nav.htm, for example, is called cb_nav.htm. 

Set up site structure for the tutorial

Before you start the tutorial, create a folder into which you'll transfer the CourseBuilder for Dreamweaver tutorial files.

If you completed the Adobe Dreamweaver tutorial and already created a Sites folder, skip step 1.

1 At the root level of your local disk, create a folder and name it Sites—for example, C:\Sites (Windows) or Hard 

Drive:Sites (Macintosh).

2 From the CourseBuilder\Tutorial folder, copy the entire cb_tutorial folder to the Sites folder.

Define a local site

Set up a local site to develop a file structure for your site. A local site contains all the files used within a specified site, 

such as HTML files, images, scripts, and other asset files. For this tutorial, you'll specify the cb_tutorial folder as the 

local site folder.

1 Launch Adobe Dreamweaver. 

A blank document opens.

2 Choose Site > New Site.

3 In the Site Definition dialog box, make sure that Local Info is selected in the Category list.

4 In the Site Name field, type my_course.

5 Click the folder icon to the right of the Local Root Folder field, navigate to the Sites\cb_tutorial folder, and then 

click Select (Windows) or Choose (Macintosh). 

The Local Root Folder field updates to display the path to the local site. 

Note: The complete path to the cb_tutorial folder may vary, depending on where you have created your Sites folder.

6 Click OK.

7 Click Create when asked if you'd like to create a cache file for the site. 

Caching the files in the cb_tutorial folder creates a record of existing files so Dreamweaver can quickly update links 

when you move, rename, or delete a file. 

The Site window now displays a list of the folders and files in the local site my_course. The list also acts as a file 

manager, allowing you to copy, paste, delete, move, and open files just as you would in the file finder or explorer 

on your own computer.

8 Leave the Site window open.

9 Click the Document window to make it active.
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Create an explore CourseBuilder Interaction

CourseBuilder Interactions cannot be added to an unsaved document. You can either start with a new document, then 

save it, or you can open an existing document.

In this tutorial, you'll add CourseBuilder Interactions to existing partially completed pages which contain the same 

elements, a background image, and a training department banner. 

Now, you'll create an explore interaction. In this interaction, users click pictures of the toy products to learn about them.

Open the file to which you'll add an explore CourseBuilder Interaction. 

1 Choose File > Open.

2 In the dialog box that appears, navigate to Sites/cb_tutorial/cb_discover, then select cb_explore.htm, and click 

Select (Windows) or Open (Macintosh) to open the file.

Copy support files

CourseBuilder for Dreamweaver requires support files that contain images and scripts; the support files enable 

CourseBuilder Interactions to function. 

You'll copy support files to the cb_discover folder.

1 Choose Modify > CourseBuilder > Copy Support Files.

A message appears advising where the support files will be copied

2 Click OK to create the necessary folders and to copy the files.

The files are copied to the cb_discover folder.

Insert a CourseBuilder Interaction

1 If the Object palette isn't already open, choose Window > Objects to open it.

2 In the Document window, click in the middle of the document to place the insertion point after existing page 

elements.

3 In the Object palette's Learning panel, click the CourseBuilder Interaction icon to open the CourseBuilder 

Interaction dialog box.

Select the type of interaction

1 Select Explore in the Category list.

The icons in the Gallery represent the explore CourseBuilder Interactions that function in version 4 and later 

browsers.

2 Click the icon for the Explore_Areas template.

Define the hot areas

You don't need to change the default settings that are in the General tab, so you'll begin by specifying the hot area 

elements of the explore interaction—graphic images of the toys the users will click.
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Add graphics for the hot areas

1 Start by clicking the Hot Areas tab.

In the Hot Areas list, Hot Area1 is already selected.

2 In the Image field, click Browse. Then, in the Select Appearance dialog box, navigate to the cb_graphics folder and 

select toy_racer.gif. 

Then click Select (Windows) or Choose (Macintosh) to display the image.

3 In the Hot Areas list, Hot Area1 is already selected.

4 In the Image field, click Browse. Then, in the Select Appearance dialog box, navigate to the cb_graphics folder and 

select toy_racer.gif. Then click Select (Windows) or Choose (Macintosh) to display the image.

Add three more hot area graphics

1 In the Hot Areas list, select HotArea2.

2 In the Image field, click Browse. Then, in the Select Appearance dialog box, navigate to the cb_graphics folder and 

select toy_coldfusion.gif. Then click Select (Windows) or Choose (Macintosh) to display the image.

3 In the Hot Areas list, select HotArea3.

4 In the Image field, click Browse. Then, in the Select Appearance dialog box, navigate to the cb_graphics folder and 

select toy_satellite.gif. Then click Select (Windows) or Choose (Macintosh) to display the image.

5 In the Hot Areas list, select HotArea4.

6 In the Image field, click Browse. Then in the Select Appearance dialog box, navigate to the cb_graphics folder and 

select toy_waverider.gif. Then click Select (Windows) or Choose (Macintosh) to display the image.

7 Click OK to close the CourseBuilder Interaction dialog box.

8 Save your file.

Arrange the hot areas in the document

Next, you'll remove the text instructions on the page, and move the hot area elements to make room for a new element 

that you'll use to provide feedback to users.

1 In the Document window, select the text "Click on a hot area" at the top of the screen, then press Backspace 

(Windows) or Delete (Macintosh) to delete it. 

2 Select the hot area element. See Dreamweaver documentation for more information on this step.

3 Click the element selection handle in the upper left corner. Now, drag the element to its new position.

Move each hot area, as necessary, to position the elements.

4 Save your changes.

Add an element for user feedback

Next, you'll create an element where both instructions to the user and the product information will appear in the page.

1 In the Insert panel, click Draw AP DIV under Layout. 

2 Move the pointer to the Document window, then drag to draw a DIV in the right side of the document.

3 Select the DIV. Then, in the Property inspector's ID field, replace the default text "apDiv1" by typing ProductInfo.
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4 In the Document window, click in the middle of the ProductInfo element.

5 Insert an image in the element.

The Select Image Source dialog box appears.

6 In the dialog box, navigate to the cb_graphics folder, select text_any.jpg, and click Select (Windows) to insert the 

image in the element.

The user instructions appear in the ProductInfo element in the Document window.

Editing a CourseBuilder Interaction

The elements are set up; however, you still need to define what happens when a user clicks one of the hot areas. To 

ensure that your interactions function correctly, always change the elements of a CourseBuilder Interaction in the 

CourseBuilder Interaction dialog box. Reopen the CourseBuilder Interaction dialog box. 

1 In the Document window, do one of the following to select the CourseBuilder Interaction:

• Click the CourseBuilder Interaction icon in the Document window.

• Click any of the hot area elements, then click <interaction> in the tag selector.

2 In the Property inspector, click Edit to open the CourseBuilder Interaction dialog box.

Create user feedback

When users clicks a hot area, they should learn about the product they selected. You'll set up a swap image to switch 

the image displayed in the ProductInfo element with an image that contains information about the product that was 

clicked.

Use the Action Manager to define what happens when a specific hot area is clicked. You'll remove the default Popup 

Message action feedback and add a Swap Image action for each hot area.

View the Action Manager tab

Start by clicking the Action Manager tab.

The Action Manager tab displays default segments and conditions based on the type of interaction selected. Segments 

preceded by a plus sign (+) are collapsed. To view the conditions and actions of a selected collapsed segment, click 

Expand in the Action Manager tab.

Action flows from the top of the list down until a defined condition is met—for example, if a user clicks Hot Area 1. 

When a defined condition is met, action flows to the next item within that segment—for example, if Hot Area 1 is 

clicked, a Popup Message would be displayed.

Although segments are automatically added in the Action Manager to check the time limit and tries limit, the actions 

for these segments aren't triggered unless you select these options in the General tab.

Add a swap image action for racer product information

1 In the Action Manager list under "if Hot Area1 Selected," select Popup Message, then click Cut.

2 Select "if Hot Area1 Selected," then in the Actions pop-up menu choose Swap Image, and click Add.

The Swap Image dialog box appears:
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In the Swap Image dialog box, "unnamed <img>" is selected. This is the image you inserted in the ProductInfo 

element. You'll swap this image for an image that describes the image in Hot Area 1, the racer.

3 In the "Set Source to" field, click Browse.

4 In the Select Image Source dialog box that appears, select text_racer.jpg, then click Select (Windows) or Choose 

(Macintosh) to display the image.

5 Click OK to close the dialog box.

Add a swap image action for Cold Fusion product information

Replace the user instruction text with text describing the Cold Fusion Kit.

1 In the Action Manager list under "if Hot Area2 Selected," select Popup Message, then click Cut.

2 Select "if Hot Area2 Selected," then in the Actions pop-up menu choose Swap Image, and click Add.

The Swap Image dialog box appears.

In the Swap Image dialog box's Images list, "image 'Image1' in layer 'ProductInfo'" is already selected, and the image 

is set to display text_racer.jpg. You'll set the image to display the correct text for Hot Area 2, the Cold Fusion 

product.

3 In the "Set Source to" field, click Browse.

4 In the Select Image Source dialog box, select text_coldfusion.jpg, then click Select (Windows) or Choose 

(Macintosh) to display the image. 

5 Click OK to close the dialog box.

Add a swap image action for satellite product information

Replace the user instruction text with text describing the satellite.

1 In the Action Manager list under "if Hot Area3 Selected," select Popup Message, then click Cut.

2 Select "if Hot Area3 Selected," then in the Actions pop-up menu choose Swap Image, and click Add.

3 In the Swap Image dialog box's Images list, "image 'Image1' in layer 'ProductInfo'" is already selected. Click Browse 

next to the "Set Source to" field to select the replacement image.

4 In the Select Image Source dialog box, select text_satellite.jpg, then click Select (Windows) or Choose (Macintosh) 

to display the image.

5 Click OK to close the dialog box.

Add a swap image action for wave-rider product information

Now, you'll replace the user instruction text with text describing the wave-rider helmet.

1 In the Action Manager list under "if Hot Area4 Selected," select Popup Message, then click Cut.

2 Select "if Hot Area4 Selected," then in the Actions pop-up menu choose Swap Image, and click Add.

3 In the Swap Image dialog box's Images list, "image 'Image1' in layer 'ProductInfo'" is already selected. Click Browse 

next to the "Set Source to" field to select the replacement image.

4 In the Select Image Source dialog box, select text_waverider.jpg, then click Select (Windows) or Choose 

(Macintosh) to display the image.

5 Click OK to close the dialog box.
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6 Click OK to close the CourseBuilder Interaction dialog box.

Create a link to the next page

Link this page to the next interaction page, the drag-and-drop quiz.

1 In the Insert panel, select Draw AP DIV from the Layout list. Now, move the pointer to the page, and drag to draw 

a DIV in the space beneath the ProductInfo element.

2 Click the DIV to select it, then move the DIV if you need to position it.

Use the element handle in the upper left corner of the element to position the element:

3 Click in the element to place the insertion point. Insert an image in the element.

4 In the Select Image Source dialog box, open the cb_graphics folder (if it's not already open), select 

Arrow_Sharp_Right.gif, and click Select (Windows) or Choose (Macintosh).

An arrow appears in the element.

5 In the Property inspector, click the folder icon next to the Link field. Then, in the Select File dialog box, navigate to 

the cb_discover folder, select cb_drag_drop.htm, and click Select (Windows) or Choose (Macintosh) to select the 

file to open when the arrow is clicked.

6 Resize the element.

7 Save your document.

Test the explore interaction

Test the page to see how the interaction works.

1 Choose File > Preview in Browser, and choose the browser you want to use.

The browser launches and displays the page.

2 Click each of the products and make sure that the correct information appears.

3 Click the arrow to see if it goes to the "Know your target audience" page.

Create a drag-and-drop interaction 

Now you'll create a drag-and-drop matching quiz. Users will test their knowledge of the products by dragging a toy to 

the target audience for which the toy is designed. 

Insert a CourseBuilder Interaction 

1 Choose File > Open. In the dialog box that appears, navigate to cb_drag_drop.htm, and click Select (Windows) or 

Open (Macintosh) to open the file.

2 If the Object palette isn't already open, choose Window > Objects to open it.

3 In the Document window, click in the middle of the document to place the insertion point after existing page 

elements.

4 In the Object palette's Common panel, click the CourseBuilder Interaction icon.

The CourseBuilder Interaction dialog box appears.



10USING ADOBE ELEARNING SUITE COURSEBUILDER EXTENSION

Dreamweaver Tutorials

Last updated 4/1/2011

Select the type of interaction

1 Select Drag and Drop in the Category list.

2 Click the icon for the many-to-many matching template.

Define the General tab options

Use the tabs in the CourseBuilder Interaction dialog box to define this interaction. As you select options in the tabs, 

you specify how the CourseBuilder Interaction will perform.

The default settings of the CourseBuilder Interactions are designed for ease of use. You'll find that most of the options 

you'd select for your interactions are the options that are set as the current defaults. You'll only need to change a few 

settings to customize the information for courses, surveys, or quizzes you're creating.

Use the options of the General tab to define how the interaction responds when a user interacts with it.

1 Click the General tab.

2 Under Judge Interaction, select "when the user drops a drag element."

This option causes feedback to display every time the user moves a toy image to a target audience image—rather 

than waiting until the user has tried to match every toy with a target audience.

3 Under Reset, accept the default setting "Create a Reset button for this Interaction."

4 Under Reaction, select "Snap back if incorrect."

This returns the toy to its original position if the user drags it to the wrong target audience.

5 Under Reaction, accept the default setting "Snap back if not dropped on target."

This returns the toy to its original position if the user drags it somewhere other than a target area.

6 Under DIV, select "Insert this Interaction in a DIV" to place the question text in a DIV, making it easy for you to 

position the text in the document. (Each of the drag-and-drop images is already in an individual DIV.)

Your General tab should be set as the shown here:

Create drag-and-drop pairs

Now you'll add the drag and drop elements to the interaction. You'll add three drag images and three target images.

Drag-and-drop matching exercises are made up of pairs of drag and target objects. For example, the satellite is a drag 

object. Its target object is an image of its target audience: kids with big imaginations. In this step, you replace the drag-

and-drop template's placeholder graphics with the images you want to use for the drag and target objects.

Add drag images

1 Click the Elements tab.

Drag1 is already selected in the Elements list.

2 In the Name field, type satellite.

3 Click the Browse button next to the Image File box. In the cb_graphics folder, select toy_satellite_mini.gif, then 

click Select (Windows) or Choose (Macintosh) to display the image for this drag object.

4 In the Elements list, select Drag2; then in the Name field, type waverider.

5 Click the Browse button. In the cb_graphics folder, select toy_waverider_mini.gif, then click Select (Windows) or 

Choose (Macintosh) to display the image for this drag object.
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6 In the Elements list, select Drag3; then in the Name field, type racer. 

7 Click the Browse button. In the cb_graphics folder, select toy_racer_mini.gif, then click Select (Windows) or 

Choose (Macintosh) to display the image for this drag object.

Add target images

Next, add the target images that match the drag objects:

1 In the Elements list, select Target1; then in the Name field, type satellitematch. 

2 Click the Browse button. In the cb_graphics folder, select kids_climbing.jpg, then click Select (Windows) or Choose 

(Macintosh).

3 In the Elements list, select Target2; then in the Name field, type waveridermatch. 

4 Click the Browse button. In the cb_graphics folder, select kids_bike.jpg, then click Select (Windows) or Choose 

(Macintosh).

5 In the Elements list, select Target3; then in the Name field, type racermatch.

6 Click the Browse button. In the cb_graphics folder, select kids_soccer.jpg, then click Select (Windows) or Choose 

(Macintosh).

Your screen should look like this.

7 Click OK to close the CourseBuilder Interaction dialog box.

Position the images in the document

Now you'll arrange the DIVs in the Document window to set up the interaction.

1 In the Document window, select a DIV by clicking its border.

2 Drag the elements in your document to match this screen layout. 

3 In the Document window, use the pointer to select the default text "Drag the objects on the left to the correct targets 

on the right, then press the 'Submit' button to check the answer." Replace the text by typing Ready to sell? Drag 

each toy to its target customer.

Create drag-and-drop pairs 

Now you'll add the drag and drop elements to the interaction. You'll add three drag images and three target images. 

Drag-and-drop matching exercises are made up of pairs of drag and target objects. For example, the satellite is a drag 

object. Its target object is an image of its target audience: kids with big imaginations. In this step, you replace the drag-

and-drop template's placeholder graphics with the images you want to use for the drag and target objects. 

Add drag images

1 Click the Elements tab.

Drag1 is already selected in the Elements list.

2 In the Name field, type satellite. 

3 Click the Browse button next to the Image File box. In the cb_graphics folder, select toy_satellite_mini.gif, then 

click Select (Windows) or Choose (Macintosh) to display the image for this drag object.

4 In the Elements list, select Drag2; then in the Name field, type waverider.
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5 Click the Browse button. In the cb_graphics folder, select toy_waverider_mini.gif, then click Select (Windows) or 

Choose (Macintosh) to display the image for this drag object.

6 In the Elements list, select Drag3; then in the Name field, type racer.

7 Click the Browse button. In the cb_graphics folder, select toy_racer_mini.gif, then click Select (Windows) or 

Choose (Macintosh) to display the image for this drag object.

Add target images

Next, add the target images that match the drag objects: 

1 In the Elements list, select Target1; then in the Name field, type satellitematch. 

2 Click the Browse button. In the cb_graphics folder, select kids_climbing.jpg, then click Select (Windows) or Choose 

(Macintosh).

3 In the Elements list, select Target2; then in the Name field, type waveridermatch. 

4 Click the Browse button. In the cb_graphics folder, select kids_bike.jpg, then click Select (Windows) or Choose 

(Macintosh).

5 In the Elements list, select Target3; then in the Name field, type racermatch. 

6 Click the Browse button. In the cb_graphics folder, select kids_soccer.jpg, then click Select (Windows) or Choose 

(Macintosh).

Your screen should look like this.

7 Click OK to close the CourseBuilder Interaction dialog box.

Position the images in the document

Now you'll arrange the DIVs in the Document window to set up the interaction. 

1 In the Document window, select a DIV by clicking its border.

2 Drag the elements in your document to match this screen layout. 

3 In the Document window, use the pointer to select the default text "Drag the objects on the left to the correct targets 

on the right, then press the 'Submit' button to check the answer." Replace the text by typing

Ready to sell? Drag each toy to its target customer.

Set snap to settings

You've already set what happens when a match is incorrect: the toy snaps back to its original position. But what 

happens when the match is correct? Where does the toy land? In this step, you'll precisely set the position of the toy 

when the toy is dragged to the correct target audience.

You need to set up the snap behavior of the correct pairs only; the incorrect pairs are already set. 

1 Click one of the images in the drag-and-drop interaction, then click <interaction> in the tag selector, and click 

Edit in the Property inspector.

2 Click the Pairs tab.

Notice that because you set matches for the Drag1 and Target1 elements, the matching pairs are already set up: 

satellite and satellitematch are a correct match, but satellite and waveridermatch are an incorrect match.
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3 Select the "satellite:satellitematch" pair if it isn't already selected.

4 Under Snap To, select "pixels down," and in the pixel down field type 70. Then "select pixels to right of the target 

element's upper left corner," and in this field type 30.

Your screen should look like this.

When a match occurs, the drag element will move to these precise positions in the target element.

5 Select the "waverider:waveridermatch" pair. 

6 Under Snap To, select "pixels down," and in the "pixels down" field type 70. Then select "pixels to the right of the 

target element's upper left corner," and in this field type 30.

7 Select the "racer:racermatch" pair. 

8 Under Snap To, select "pixels down," and in the "pixels down" field type 70. Then select "pixels to the right of the 

target element's upper left corner," and in this field type 30.

* Not grayed when disabled

Create user feedback

Users get feedback only if they make a match that's correct. If a match is wrong, the toy snaps back to its original 

position so the user can try again. The entire interaction is correct only when the user gets all three matches correct. 

For this interaction there are two different types of feedback: one when a match is correct, one when the entire 

interaction is correct.

Set feedback for a correct response

The "if Correct" condition controls what happens when the entire interaction is correct.

1 Click the Action Manager tab.

2 Select the Popup Message action under "if Correct," and click Edit.

The Popup Message dialog box appears.

3 In the dialog box's Message field, change the default text, "Correct," by typing You're ready to sell!

4 Click OK to close the dialog box.

Delete default feedback for an incorrect or unknown response

You won't set the next condition, "else if Incorrect," because you aren't providing feedback to users when they make 

an incorrect match. Additionally, you won't set a response for "else if Unknown Response," because it's impossible for 

users to respond in a way that you can't identify.

1 Select "else if Incorrect," and click Cut.

2 Select "else if Unknown Response," and click Cut.

The conditions and their associated Popup Message actions are automatically cut.
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Add correct match feedback

Now you'll add another condition to provide users with feedback when they make a correct match while in the process 

of completing the interaction. Until the entire interaction is complete with the "all correct and none incorrect" 

condition met, correct matches receive this feedback.

1 In the Action Manager list, select the Popup Message action below "if Correct," choose Else from the Actions pop-

up menu, and click Add.

Else is added to the Action Manager list. 

2 With "-- else" selected, choose Popup Message in the Actions pop-up menu, and click Add.

The Popup Message dialog box appears.

3 In the Message field, type That's right!.

4 Click OK to close the dialog box.

5 Click OK to close the CourseBuilder Interaction dialog box.

6 Choose File > Save to save your document.

Create a link to the next interaction

Link this page to the final page of your course, the multiple-choice quiz. 

1 In the Insert panel, select Draw AP DIV from the Layout list. Now, move the pointer to the Document window, and 

drag the pointer to draw an AP DIV in the lower right area of the document.

2 Select the AP DIV and position it using the Property inspector.

3 Click in the AP DIV. Now, in the Insert panel, select Images > Image from the Common list.

4 In the Select Image Source dialog box, navigate to the cb_graphics folder, select Arrow_Sharp_Right.gif, and click 

Select (Windows) or Choose (Macintosh). 

An arrow appears in the DIV.

5 In the Property inspector, click the folder icon next to the Link field to select the file to open when the arrow is 

clicked.

6 In the Select File dialog box, in the cb_discover folder, select cb_mc.htm, and click Select (Windows) or Choose 

(Macintosh).

7 Click the border of the DIV to select it, then use one of the DIV handles to resize it to fit the graphic.

Test the drag-and-drop interaction

Test the page to see how it works: 

1 Choose File > Save, then choose File > Preview in Browser.

The browser launches and displays the page.

2 Drag the toys to the descriptions.

These are the correct matches:

• Satellite and "Kids 12 to 14 with big imaginations"

• Wave-rider helmet and "Kids 8 to 14 who bike to school"

• Racer and "Preteen boys looking for a testosterone rush"
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When you drag a toy to the wrong target, it should snap back to its original position.

When you drag a toy to the right target, a message should appear saying, "That's right!"

When you match all the toys with their correct targets, a message should appear saying, "You're ready to sell!"

Create a multiple-choice quiz 

In this part of the tutorial you'll create a multiple-choice quiz. When the user selects from a list of choices, feedback is 

provided based on the user's correct or incorrect response. 

Insert a CourseBuilder Interaction 

1 Choose File > Open. In the dialog box that appears, navigate to the cb_discover folder and then to cb_mc.htm, and 

click Select (Windows) or Open (Macintosh) to open the document.

2 If the Object palette isn't already open, choose Window > Objects to open it.

3 In the Document window, click in the middle of the document to place the insertion point after existing page 

elements. 

4 In the Object palette's Common panel, click the CourseBuilder Interaction icon to open the CourseBuilder 

Interaction dialog box.

Select the type of interaction

1 Select Multiple Choice in the Category list.

2 Click the icon for the graphic multiple-choice template. 

Define the multiple-choice interaction

1 Click the General tab. 

2 In the Question Text field, delete the default text.

3 Under Judge Interaction, select "when the user clicks a choice," if it isn't already selected.

4 In Correct When, accept the default setting Any Correct and None Incorrect.

5 In Tries Are and Time Is, accept the default settings, Unlimited. 

6 Verify that the Reset option is not selected.

7 Select "Insert this Interaction in a DIV tag," to place the CourseBuilder Interaction in an AP DIV so you can easily 

position it in the document. 

Define the correct choice

Use the Choices tab to define the interaction choices and to define whether a choice is correct or incorrect. 

1 Click the Choices tab.

In the Choices list, choice1 is already selected and marked as correct. 

2 Under Choice Options, in the Name field, change the default text "choice1" by typing waverider.
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3 Delete the text in the Text field.

4 In the Image File field, click Browse.

5 In the Select Appearance dialog box, navigate to the cb_graphics folder, then select toy_waverider_mini.gif, and 

click Select (Windows) or Choose (Macintosh).

The Choices tab updates

Define incorrect choices

Now you'll set images for the other incorrect interaction choices. 

1 In the Choices list, select choice2. 

Notice that "Choice Is" is marked incorrect. 

2 Under Choice Options, in the Name field, change the default text "choice2" by typing coldfusion.

3 Delete the text in the Text field.

4 In the Image File field, click Browse. Then, in the Select Appearance dialog box, navigate to the cb_graphics folder, 

select toy_coldfusion_mini.gif, and click Select (Windows) or Choose (Macintosh).

5 In the Choices list, select choice3.

6 Under Choice Options, in the Name field, change the default text "choice3" by typing racer.

7 Delete the text in the Text field.

8 In the Image File field, click Browse. Then, in the Select Appearance dialog box, navigate to the cb_graphics folder, 

select toy_racer_mini.gif, and click Select (Windows) or Choose (Macintosh).

9 In the Choices list, select choice4.

10 Under Choice Options, in the Name field, change the default text "choice4" by typing satellite.

11 Delete the text in the Text field.

12 In the Image File field, click Browse. Then, in the Select Appearance dialog box, navigate to the cb_graphics folder, 

select toy_satellite_mini.gif, and click Select (Windows) or Choose (Macintosh).

13 Click OK to close the CourseBuilder Interaction dialog box.

Create a layer for user feedback

In the document, you'll position the layer containing the interaction choices, then create a layer in the document where 

both the quiz question and the user feedback will appear. 

1 In the Document window, click the border of the interaction DIV to select the layer.

2 Click the Layer tab then drag the layer. 

3 In the Insert panel, select Draw AP DIV from the Layout list. Then move the pointer to the Document window, and 

in the area to the left of the choices, drag the pointer to draw an AP DIV.

4 With the DIV selected, in the Property inspector's ID field, replace the default text "apDiv1" by typing Feedback.

5 In the Document window, click in the Feedback DIV to position the insertion point in the DIV. Now, in the Insert 

panel, select Images > Image from the Common list.

6 In the Select Image Source dialog box, navigate to the cb_graphics folder, and select text_mc_question.jpg, and click 

Select (Windows) or Choose (Macintosh). 
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7 With the image selected, in the Property inspector's Image field, name the image feedback

8 Move the DIV if you need to so it doesn't overlap the DIV containing the choices.

Create user feedback

When users make a choice, you'll give them feedback using the same technique you used to display product 

information earlier: you'll have the Action Manager swap the image of the question with an image containing the 

feedback.

Set up feedback for a correct response

1 Click anywhere in the layer containing the choices. Then, in the tag selector click <interaction>, and in the Property 

inspector click Edit to open the CourseBuilder Interaction dialog box.

2 Click the Action Manager tab.

3 In the Action Manager list under "if Correct," select Popup Message, and click Cut.

4 In the Action Manager list reselect "if Correct," then choose Swap Image from the Actions pop-up menu, and click Add.

The Swap Image dialog box appears.

5 In the Images list, select "image in the Feedback layer," then click Browse.

6 In the Select Image Source dialog box, navigate to the cb_graphics folder, select text_feedback_correct.jpg, and click 

Select (Windows) or Choose (Macintosh). 

7 Click OK to close the Swap Image dialog box.

Set up feedback for wrong response

Next, you'll set the feedback for an incorrect choice. 

1 In the Action Manager list under "else if Incorrect," select Popup Message, then click Cut.

2 In the Action Manager list re-select "else if Incorrect," then choose Swap Image from the Actions pop-up menu, and 

click Add.

The Swap Image dialog box appears.

3 In the Images list, select "image in the Feedback layer," then click Browse.

4 In the Select Image Source dialog box, navigate to the cb_graphics folder, and select text_feedback_incorrect.jpg, 

and click Select (Windows) or Choose (Macintosh).

5 Click OK to close the Swap Image dialog box.

6 Click OK to close the CourseBuilder Interaction dialog box.

Test the interaction

Now test the page to see how it works.

1 Choose File > Save, then press F12 to preview the page in a browser.

2 When the document opens try the interaction:

• Click the first button, and you receive feedback that your choice is right.
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• Click the other three buttons, and you receive feedback that your choice is wrong.

Create a Multiple-choice interaction 

You're now ready to create a navigation page from which users can select how they want to navigate your site. They 

can choose to learn about the products, test their knowledge of the products, or take a sales incentives quiz. 

Now you'll see another way to use a multiple-choice interaction. 

Open the file to which you'll add a multiple-choice CourseBuilder Interaction. 

1 Choose File > Open.

2 In the Open dialog box, navigate to the cb_discover folder, then select the file named cb_nav.htm, and click Open.

Insert a CourseBuilder Interaction 

1 If the Object palette isn't already open, choose Window > Objects to open it.

2 In the Document window, click in the middle of the document to place the insertion point after existing page 

elements. 

You can't see the invisible markers in the document because they are obscured by the banner image.

3 In the Object palette's Common panel, click the CourseBuilder Interaction icon.

The CourseBuilder Interaction dialog box appears displaying the Gallery tab. 

Select the type of interaction 

Use the options in the Gallery tab to select an interaction template. You can choose a target browser to see a list of 

interactions that will work on the specified browser version and you can use the Category list to select an interaction 

type. The icons in the Gallery show which templates are available for a selected interaction type. 

1 In the Category list, select Multiple Choice.

The icons in the Gallery represent the multiple-choice CourseBuilder Interactions that will function in version 4 

and later browsers.

2 Click the icon for the graphic multiple-choice with radio buttons template. 

Notice that as you place the pointer over the template icons, the template's name appears in the blank space below 

the Gallery. 

The CourseBuilder Interaction dialog box displays additional tabs next to the Gallery tab. Use these tabs to define 

the properties, elements, and actions of the interaction. 

The framework of the multiple-choice template is visible in the Document window. To see the CourseBuilder 

Interaction in the Document window, drag the CourseBuilder Interaction dialog box down or to the right, if 

necessary. 
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Define the multiple-choice interaction

Select options on the General tab to define general properties that apply to the overall multiple-choice interaction. 

1 Click the General tab. 

2 In the Question Text field, replace the text "Put your question text here" by typing:

Here's the latest on our new line of toys - specs, prices, and this quarter's sales 
incentives. Explore first, then test your knowledge with a couple of quizzes.  
Click a button to choose:

The text instantly updates in the Document window when you click another field on this tab.

3 Under Judge Interaction, accept the default setting, "when the user clicks a choice."

This option dictates that the interaction is instantly judged when a user makes a selection. 

4 In Correct When, accept the default setting, Any Correct and None Incorrect.

5 In Tries Are and Time Is, accept the default settings, Unlimited.

You aren't limiting the number of tries, nor the amount of time the user has to respond correctly to the question in 

this interaction.

6 Verify that the Reset option is not selected.

7 Select "Insert this Interaction in a DIV tag" to place the CourseBuilder Interaction in an AP DIV so you can easily 

position it in the document. 

Define the choices

Use the Choices tab to define the user's choices in the interaction. You'll name each choice so you can easily identify 

them in other tabs, add text to create the user's choices, and define how each choice is judged.

1 Start by clicking the Choices tab. 

In the Choices list, "choice1(correct)" is already selected. 

2 In the Name field, replace the default text "choice1" by typing Explore.

3 In the Text field, replace the default text "Text for choice1" by typing Explore the new products. 

This is the text the user sees on the screen.

4 In the Choice Is pop-up menu, select Not Judged. 

This interaction guides navigation, so a user's choice isn't correct or incorrect. 

5 In the Choices list, click "choice2" to select it.

Notice that the Name field changes; it now matches the selected choice in the Choices list.

6 In the Name field, replace the default text "choice2" by typing DD.

7 In the Text field, replace the default text "Text for choice2" by typing Know your target customer.

8 In the Choice Is pop-up menu, select Not Judged.

9 In the Choices list, click "choice3" to select it.

10 In the Name field, replace the default text "choice3" by typing MC.
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11 In the Text field, replace the default text "Text for choice3" by typing What's in it for you.

12 In the Choice Is pop-up menu, select Not Judged.

13 In the Choices list, select "choice4" then click Delete to remove this choice from the interaction.

Define the action 

Complete the interaction by defining the action that CourseBuilder executes in response to the user's choices. You'll 

link each choice with a file to open when clicked. Use the Action Manager to set up a Go To URL action for each choice.

• If a user selects choice 1, the explore activity page is displayed

• If a user selects choice 2, the drag-and-drop quiz page is displayed

• If a user selects choice 3, the multiple-choice quiz page is displayed

While defining this interaction, you'll change the default settings of the segments, conditions, and actions to customize 

the feedback. 

Select the Action Manager tab

Start by clicking the Action Manager tab.

The Action Manager tab displays three segments:

• Segment: Check Time

• Segment: Correctness

• Segment: Check Tries

Although segments are automatically set up for a time limit and tries limit, they aren't triggered unless you select the 

time or tries limit options in the General tab. 

Actions to provide users with feedback are already set for each default Action Manager segment. You'll change the 

default settings of the segments, conditions, and actions to customize the feedback for your interaction. 

Segments preceded by a plus sign (+) are collapsed. To view the conditions and actions of collapsed segments, click 

Expand on the Action Manager tab. 

Edit the segments

You'll change the default segment name to a name that identifies what the segment does.

1 In the Action Manager list, select Segment:Correctness to select this segment. 

2 Click Edit. 

The Segment Editor appears. 

3 In the Segment Name field, replace the default text, by typing Navigation.

4 Click OK to close the dialog box.

Define the explore condition

1 In the Action Manager list, select the "if Correct" condition.

2 Click Edit.
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The Condition Editor appears. 

3 In the Condition Name field, type Explore selected to indicate which condition is represented.

4 In the rightmost Interaction pop-up menu, which currently shows <none>, select Button "Explore."

5 In the bottommost Type pop-up menu, make sure True is selected. 

6 Click OK to close the dialog box.

Add a Go To URL action

Now add the action that takes the user to the correct URL when this choice is selected. First you'll delete the existing 

Popup Message action, then you'll add a Go To URL action. 

1 In the Action Manager list, under "if Explore selected," select Popup Message.

2 Click Cut to delete this action from the Action Manager list.

3 In the Action Manager, select "if Explore selected."

4 In the Action Manager pop-up menu, choose Go To URL, then click Add.

The Go To URL dialog box appears. 

5 In the URL field, click Browse.

6 In the dialog box that appears, navigate to the cb_discover folder, then to cb_explore.htm, and click Select 

(Windows) or Choose (Macintosh) to select the file to open when the choice is clicked.

The URL field updates.

7 Click OK to close the dialog box.

Define the drag-and-drop condition

1 In the Action Manager list, select the "else if Incorrect" condition.

2 Click Edit to open the Condition Editor.

3 In the Condition Name field, type Drag and Drop selected to indicate which condition is represented.

4 In the rightmost Interaction pop-up menu, select Button "DD."

5 In the bottommost Type pop-up menu, make sure True is selected.

6 Click OK to close the dialog box.

Add a Go To URL action

Add the action which takes the user to the drag-and-drop quiz when this choice is selected. Delete the existing Popup 

Message action, then add a Go To URL action. 

1 In the Action Manager list, under "else if Drag and Drop selected," select Popup Message.

2 Click Cut to delete this action from the Action Manager list.

3 In the Action Manager, select "else if Drag and Drop selected."

4 In the Action Manager pop-up menu, choose Go To URL, then click Add.



22USING ADOBE ELEARNING SUITE COURSEBUILDER EXTENSION

Dreamweaver Tutorials

Last updated 4/1/2011

5 In the Go To URL dialog box, in the URL field, click Browse. Then, in the dialog box that appears, navigate to 

cb_drag_drop.htm in the tutorial folder, and click Select (Windows) or Choose (Macintosh) to select the file to 

open when the choice is clicked.

6 Click OK to close the dialog box.

Define the multiple-choice condition

1 In the Action Manager list select the "else if Unknown Response" condition.

2 Click Edit to open the Condition Editor.

3 In the Condition Name field, type Multiple Choice selected to indicate which condition is represented.

4 In the right most Interaction pop-up menu, select Button "MC."

5 In the bottommost Type pop-up menu, make sure True is selected. 

6 Click OK to close the dialog box.

Add a Go To URL action

Add the action that takes the user to the multiple-choice quiz page when Choice 3 is selected. Delete the existing Popup 

Message action, then add a Go To URL action. 

1 In the Action Manager list, under "else if Multiple Choice selected," select Popup Message.

2 Click Cut to delete this action from the Action Manager list.

3 In the Action Manager, select "else if Multiple Choice selected”.

4 In the Action Manager pop-up menu, choose Go To URL, then click Add.

5 In the Go To URL dialog box, in the URL field click Browse. Then in the dialog box that appears, navigate to 

cb_mc.htm in the cb_discover folder, and click Select (Windows) or Choose (Macintosh) to select the file to open 

when the choice is clicked.

6 Click OK to close the dialog box, then click OK to close the CourseBuilder Interaction dialog box.

7 Choose File > Save to save your document.

Position the interaction in the document

You may need to change the size and position of the DIV that contains the multiple-choice interaction object. 

1 Click the border of the DIV to select it.

2 Then do the following to resize or move the DIV:

• Use the DIV tab (on the upper left corner) to drag the DIV to the desired location.

• Drag any of the DIV handles to resize the DIV.

3 Save your changes.
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Test the interaction 

1 Choose File > Preview in Browser. 

Your browser opens and displays the interaction.

2 Click each of the buttons to test your site.

The other interaction pages you created appear.

3 Close your browser when you are done testing your site.
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Chapter 3: CourseBuilder for 
Dreamweaver basics

Overview of CourseBuilder Basics

CourseBuilder for Dreamweaver includes an easy to use interface which helps you create web-based learning 

interactions.

About the CourseBuilder for Dreamweaver work area

After installing CourseBuilder for Dreamweaver, you will see CourseBuilder options in the Dreamweaver menus and 

in the Objects panel.

As with Dreamweaver, begin by creating a local site for your CourseBuilder for Dreamweaver documents. For 

information about creating a local site, see the "Planning and Setting Up Your Site" chapter in the Dreamweaver 

documentation.

CourseBuilder for Dreamweaver's functionality is initiated when you insert a CourseBuilder Interaction in a 

document. As you get started with CourseBuilder for Dreamweaver, you will notice the work area components and 

commands.

Copying support files

Use the Copy Support Files command to copy CourseBuilder for Dreamweaver support files to the local site folder you 

have established for your site. Using this command adds two folders to your site structure; the Scripts folder, a folder 

that contains JavaScript files, and the Images folder, a folder which contains graphics elements such as placeholder 

images, button images, slider images, and timer images. CourseBuilder Interactions require these script and image 

support files to function correctly.

Note: If your current file structure contains a folder named Images, CourseBuilder for Dreamweaver copies the image 

support files into that folder. If you want to keep CourseBuilder support files separate from your graphic files, you may 

want to rename your graphics file before copying the support files.

To copy support files:

1 Do one of the following:

• Open a new document, then save it to your local site folder.

• Open an existing document from within your local site folder.

2 Choose Modify > CourseBuilder > Copy Support Files.

3 Select the options you want, then click OK.

The Copy Support Files command always copies the script files.

You can copy image files from the Dreamweaver CS5\CourseBuilder folder to the folder where the document is 

located. You can also overwrite existing image files.
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Note: Transfer CourseBuilder for Dreamweaver support files also to your web server when publishing your web site. 

You can use the Adobe Dreamweaver Site window to copy HTML pages and dependent files. CourseBuilder support 

files, however, are not seen as dependent files and are not automatically copied to a remote server.

CourseBuilder interactions

The CourseBuilder interaction icon on the palette

The CourseBuilder Interaction icon appears on the Object palette's Learning panel.

The CourseBuilder interaction icon in the document

After inserting a CourseBuilder interaction in a document, the CourseBuilder interaction icon appears in the 

document.

Use the CourseBuilder Interaction icon to select a CourseBuilder Interaction when you want to cut, copy, clear, or edit 

a CourseBuilder Interaction.

The CourseBuilder Interaction icon remains visible even when View > Invisible Elements is turned off.

The interaction tag

When a CourseBuilder Interaction is selected, the interaction tag, <interaction>, appears in the tag selector.

If you cannot locate the CourseBuilder Interaction icon in a document (it may be obscured by other elements in a 

document, such as a DIV), use the interaction tag to select the CourseBuilder Interaction.

The CourseBuilder Interaction Property inspector

When an interaction is selected, the CourseBuilder Interaction Property inspector is displayed. Use it to make edits to 

a selected CourseBuilder Interaction.

Name lists each CourseBuilder Interaction in the document. Use the pop-up menu to select an interaction to edit.

DIV places a CourseBuilder Interaction into its own AP DIV. 

Edit displays the CourseBuilder Interaction dialog box. Click Edit to change the settings for the selected Interaction.

Inserting a CourseBuilder Interaction

Save the document before inserting a CourseBuilder Interaction.

1 In the Document window, position the insertion point where you want the Interaction to appear.

2 Choose Insert > CourseBuilder Interaction.

The CourseBuilder Interaction Gallery appears.

3 Select the interaction of your preference.
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CourseBuilder Interaction Gallery

The CourseBuilder Interaction Gallery lists the categories of Interactions and displays an icon representing each of the 

Interaction templates.

Use the Target option in the upper left corner to display only the templates that work in the browser version you target.

You can create custom templates and add them to the Gallery. Add new categories to the Interactions list to 

accommodate new classes of custom templates.

Copying files to the web server

When you transfer your completed CourseBuilder for Dreamweaver documents to the web server, copy the following 

files:

• Images for buttons and timers (in the Images folder)

• Images called by the Swap Image action

• The Scripts folder

• Any custom scripts (JavaScript files) a page uses

• Other external media, such as sounds, web-packaged Authorware pieces, and so on

Troubleshooting

Here are some tips for avoiding problems when you are working with CourseBuilder Interactions.

Creating forms and form elements

Form elements cannot be added to CourseBuilder Interactions. To build multiple-choice or text entry interactions, 

insert a CourseBuilder Interaction on the page, then add and name elements using the CourseBuilder Interaction 

dialog box.

Creating DIVs

DIVs cannot be used as elements in a CourseBuilder Interaction. To build a drag-and-drop or explore interaction, 

insert an interaction on the page, then add and name elements using the CourseBuilder Interaction interface.

Naming elements

Directly changing the names of CourseBuilder Interaction page elements causes problems. Page elements created 

using CourseBuilder are given unique names, such as "G01Question." Rename page elements only in the 

CourseBuilder Interaction dialog box.

Cutting, copying, pasting, and clearing

Use the Cut, Copy, Paste, and Clear commands on the Edit menu to edit CourseBuilder Interactions. Use the special 

Edit > Clear command to completely remove all HTML code related to a selected CourseBuilder Interaction.
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Placing CourseBuilder Interactions in AP DIVs

Do not drag or paste CourseBuilder Interactions into AP DIVs. To place an Interaction in a DIV, select the Insert in 

DIV option, either in the Property inspector or on the General tab.

Inserting multiple CourseBuilder Interactions on a page

Do not nest CourseBuilder Interactions. Before inserting a new Interaction, ensure that the insertion point is not inside 

an existing<interaction> tag.

Behaviors and custom scripts

Many page elements created using CourseBuilder for Dreamweaver contain custom scripts, which may show up in the 

Behavior inspector. Do not delete or alter these scripts, and avoid adding other actions to these elements. To add 

actions, use the Action Manager.
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Chapter 4: Multiple-Choice CourseBuilder 
Interactions

Introduction

Multiple-choice interaction overview

Use multiple-choice CourseBuilder Interactions to create surveys, drill and practice learning activities, tests, and 

assessments. You can track quizzes to determine if further instruction might be necessary, and you can collate survey 

results.

You can combine several multiple-choice CourseBuilder Interactions with an Action Manager CourseBuilder 

Interaction to track scores that a user receives for each of the multiple-choice interactions, and then total the scores for 

an entire test. You can also introduce feedback when a user chooses an incorrect answer.

A multiple-choice CourseBuilder Interaction presents users with a group of images, text items, or both from which to 

choose; then it exhibits actions based on which items the user selects.

The multiple-choice templates

You can choose from six multiple-choice CourseBuilder Interaction templates, and then use the CourseBuilder 

Interaction dialog box to customize the interaction (including the number and source files of the graphics, radio 

buttons, and check boxes that the CourseBuilder Interaction contains):

MultCh_TrueFalse: true/false question

Contains a block of text followed by two radio buttons labeled True and False. The CourseBuilder Interaction judges 

a user's response as soon as the user clicks a choice. It displays feedback if the user answers correctly, incorrectly, or if 

the user does not select either radio button. 

MultCh_Radios: multiple-choice question (radio buttons)

Contains a block of text followed by four choices labeled with placeholder text. The choices are preceded by standard 

form radio buttons. In one multiple-choice template, the choices are preceded by standard form radio buttons. In the 

other template, they are preceded by graphic buttons. The first choice is correct. The CourseBuilder Interaction judges 

a user's response as soon as the user clicks a choice. The CourseBuilder Interaction displays feedback if the user 

answers correctly, incorrectly, or if the user does not select a radio button.

MultCh_ImageRadios: multiple-choice question (graphic buttons)

Contains a block of text followed by four choices labeled with placeholder text. The choices are preceded by graphic 

buttons. The graphic multiple-choice template contains a block of text followed by four choices represented by 

placeholder graphics. The first choice is correct. The CourseBuilder Interaction judges a user's response as soon as the 

user clicks a choice. The CourseBuilder Interaction displays feedback if the user answers correctly, incorrectly, or if the 

user does not select anything. 
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MultCh_ImageButton: all-that-apply question (form check boxes)

Contains a block of text followed by four choices labeled with placeholder text. The choices are preceded by standard 

form check boxes. The all-that-apply templates contain a block of text followed by four choices labeled with 

placeholder text. In one all-that-apply template, the choices are preceded by standard form check boxes. In the other 

template, they are preceded by graphic check boxes. The first two choices are correct. The CourseBuilder Interaction 

judges a user's response when the user clicks Submit.

The CourseBuilder Interaction has a Reset button that lets the user start over either before or after clicking Submit.

The CourseBuilder Interaction displays feedback if the user answers correctly, incorrectly, or if the user responds in a 

way that cannot be evaluated (for example, if the user clicks Submit before selecting any choices). 

MultCh_Checkboxes: all-that-apply question (graphic check boxes)

Contains a block of text followed by four choices labeled with placeholder text. The choices are preceded by graphic 

check boxes.

MultCh_ImageChkboxes: graphic multiple-choice question (images)

Contains a block of text followed by four choices represented by placeholder graphics.

Creating a true/false question

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction dialog box, select Multiple Choice from the Category list.

3 Select the true/false question icon.

4 Click the General tab and then in the Question Text box, replace the default text with the text of your question.

If the correct answer is True:

• Click OK.

If the correct answer is False, then do the following:

• Click the Choices tab.

• In the Choices list at the top of the tab, select choice1 (which corresponds to true). Change the Choice Is setting at 

the bottom of the tab to Incorrect.

• In the Choices list, select choice2 (which corresponds to false). Change the Choice Is setting at the bottom of the 

tab to Correct.

• Click OK.

Replacing "True" and "False" with different words

1 In the Choices tab, go to Choices list, and then select choice 1.

2 In Choice Options, in the Text (optional) field, replace True with the text you want to use.

3 In the Choices list, select choice2.

4 In Choice Options, in the Text (optional) field, replace False with the text you want to use.

5 Click OK to close the CourseBuilder Interaction dialog box.
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Multiple-choice questions

Creating a multiple-choice question

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction dialog box, select Multiple Choice from the Category list, then select the icon for 

the multiple-choice template you want to use.

3 Click the General tab. In the Question Text box, replace the default text with the text of your question.

4 Click the Choices tab, in the Choices list, select the first choice, and type the text of the correct answer in the Text 

field (you can change the order of the answers later). Repeat for each of the wrong answers.

5 Arrange the order of the answers.

6 Click OK.

Creating a graphic multiple-choice question

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the Category list, select Multiple Choice to see the multiple-choice templates.

3 Select the graphic multiple-choice icon.

4 Click the General tab. In the Question Text box, replace the default text with the text of your question.

5 In the Choices tab, go to Choices list and select a choice to set an image for.

6 In the Appearance field, click Browse and navigate to the image you want to display for the selected choice. Repeat 

for each of the other choices in the interaction.

7 Arrange the order of the answers.

8 Click OK.

Creating an all-that-apply question

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction dialog box, in the Category list, select Multiple Choice, then the icon for the all-

that-apply template you want to use.

3 Click the General tab. In the Question Text box, replace the default text with the text of your question.

4 Click the Choices tab. In the Choices list at the top of the tab, select the first choice, and type the text of the first 

correct answer in the Text field. Repeat for the second correct answer and for each of the wrong answers.

5 Arrange the order of the answers.

6 Click OK.
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The multiple-choice CourseBuilder Interaction options

General tab

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. The settings on 

the Tracking tab specify interaction properties that may be recorded by a CMI or database server application. Use 

JavaScript variables to check the current value of these properties.

Field Description

Interaction Name Unique name of the interaction.

Judge 

Interaction

Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager.

•  When the user clicks a button labeled ____: Adds an HTML form button to the page. The CourseBuilder 

Interaction starts the evaluation when that button is clicked.

• When a user clicks a choice.

• On a specific event (set using the Judge Interaction Behavior): Starts the evaluation when some other action 

associated with the CourseBuilder Interaction occurs. Use either the Dreamweaver Behavior inspector or the 

Action Manager CourseBuilder Interaction to define the Judge Interaction action that initiates the 

evaluation.

Question Text The text of the question, statement, or instruction that precedes the choices.

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you 

have one installed. When you check this option, a Tracking tab appears where you enter more information 

about scoring for the CourseBuilder Interaction. 

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as 

correct within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as 

correct if the response corresponds to any of the correct answers.

•  All Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct 

only if the response corresponds to all of the correct answers.

Time Is Determines the amount of time in seconds that the user has to complete the interaction. Use the Action 

Manager to define or edit the actions that occur when time runs out.

Time Are Determines the number of tries a user has to complete the interaction. Use the Action Manager to define or 

edit the actions that occur when the user exhausts the number of tries. 

Reset Adds an HTML form button to the CourseBuilder Interaction to clear user input during the interaction. Clicking 

the Reset button or refreshing the page in the browser window does not, however, deselect any selected radio 

buttons in a multiple-choice CourseBuilder Interaction. 

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder 

Interaction on the page.

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight An optional setting to indicate the relative importance of the interaction. CMI systems may use the value 

of this property for scoring and grading students. 
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Choices tab

The Choices tab, which appears whenever you create or edit a multiple-choice CourseBuilder Interaction, defines the 

individual choices in a multiple-choice interaction and any properties that apply to them.

Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions if a user:

• Selects or deselects a toggle switch

• Clicks a push button

• Reaches a time limit that you set on the General tab

• Reaches the number of tries that you set on the General tab

Editing multiple-choice interactions

Changing the order of the choices

1 In the Choices tab, go to Choices list and select the name of the choice you want to move.

2 Click Up or Down to change the order in which the choice displays in the interaction.

Field Description

Choices Lists all the choices in the CourseBuilder Interaction. Use the buttons to add, delete, and rearrange choices.

Name Identifies the selected choice. The name of a choice is different from the text of the choice. The text of a choice 

is what appears on the page; it is what the user sees. The name of the choice appears only in the CourseBuilder 

Interaction dialog box. The name is case sensitive and cannot be reused for another choice. All characters 

must be alphanumeric, and the name cannot contain spaces. 

Text Adds the text you type in the field to the selected choice. Customize the text in the Dreamweaver document. 

For example, true.

Image File The name of an image file associated with the text of a choice. Do not use this option for graphic buttons or 

check boxes or for graphics-only questions; use the Appearance option instead.

Appearance Defines either the graphic images used as the choices in multiple-choice CourseBuilder Interactions 

containing only graphics, or defines the graphic buttons and check boxes used in place of form radio buttons 

and check boxes. These images are active: users can click them. Any graphic files defined in the Image File 

field are displayed with the choice but are not active.

Choice Is Defines the current choice as correct, incorrect, or not judged. How the choice is judged determines the type 

of feedback the user receives when clicking that choice. 

Score Assigns a score to the choice. The score is passed to a management system for tracking, or called and 

displayed through custom JavaScript. 

Edit Options • Add creates an entry in the Choice list.

• Delete removes the selected entry from the Choice list. 

• Up and Down reorders the list, moving a choice to a different location on the page.

Place before text Puts the image in front of all text when the current choice appears on the page. This option applies only to 

the selected choice and must be individually reapplied to other choices in the CourseBuilder Interaction.
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Adding or deleting a choice

To delete a choice:

In the Choices tab, go to Choices list and select the name of the choice you want to delete, then click Delete.

To add a choice:

1 In the Choices tab, go to Choices list and select the name of the choice whose properties are most like the one you 

want to add.

2 Click Add.

The choice is duplicated.

3 Name the choice.

4 Change the properties (that need modification).

5 Arrange the choice's position in the Choices list.

Naming a choice

The name of a choice is different from the text of the choice. The text of the choice is what appears on the page; it is 

what the user sees. The name of the choice appears only in the CourseBuilder Interaction dialog box.

The templates assign default names (choice1, choice2, and so on) to each choice. Change the default names to 

something more descriptive to make the choices easier to work with. However, you should avoid naming choices in 

ways that describe whether a choice is correct or incorrect. Because clever users can look at the HTML, you do not 

want them to be able to determine the answer based on the names of the choices.

Change the name of a choice:

1 In the CourseBuilder Interaction dialog box, click the Choices tab.

2 In the Choices list at the top of the tab, select the name of the choice you want to change.

3 In the Name field, replace the default name with the name you want. The name can consist only of letters and 

numbers. Invalid characters, including spaces, are automatically deleted.

Adding an image to a text choice

Do not confuse an image you add to a text choice with a graphic multiple-choice question. Adding an image to a text 

choice merely enhances it. If you want to create a multiple-choice question that is essentially graphic and that needs 

no text, use the graphic multiple-choice question template.

Add an image to a choice:

1 In the CourseBuilder Interaction dialog box, click the Choices tab.

2 In the Choices list at the top of the tab, select the name of the choice you want to add an image to.

3 In the Image File, click Browse, then navigate to the image you want to display for the choice.

The "Place before text" option is selected by default. The image appears to the left of the text of the choice.

To have the image appear to the right of the text of the choice:

Deselect the "Place before text" option.
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Chapter 5: Drag-and-Drop CourseBuilder 
Interactions

Introduction

Drag-and-drop interaction overview

Drag-and-drop CourseBuilder Interactions offer users hands-on learning in which they interact directly with a lesson 

by manipulating elements on-screen. Use the drag-and-drop CourseBuilder Interaction to have students demonstrate 

that they have mastered complex relationships between objects. For example, have users assemble a piece of machinery 

from its parts or relate concepts spatially.

You can include guidance to demonstrate the consequences of using a complex system incorrectly. Consider using 

feedback on incorrect or undesirable responses to guide students and explain flaws in logic. To give a drag-and-drop 

interaction depth and make it less predictable and more challenging, make sure that drag-and-drop interactions are 

real enough to handle and give feedback on a wide variety of gestures.

The drag-and-drop templates

You can choose from seven drag-and-drop CourseBuilder Interaction templates, and then use the CourseBuilder 

Interaction dialog box to customize the drag-and-drop interaction.

The following are some of the features common to all drag-and-drop templates:

• If a user drops an element anywhere within 75 pixels of the center of another element, the center of that element 

snaps to the center of the target element. If a user drops a drag element, but misses the target, the drag element snaps 

back to its original position.

• The CourseBuilder Interaction has a Reset button that lets the user start over 

Drag_ManyToMany: one-to one matching

Places three drag elements and three target elements on the page. Each target element is the correct match for only one 

drag element. 

Because this interaction contains several drag elements, the CourseBuilder Interaction is set up to judge a user's 

response when the user clicks Submit.

When there is a single drag element, it is more efficient to have the CourseBuilder Interaction judge the interaction as 

soon as the user drops the element. A user must match all three drag elements with their correct target elements for 

the CourseBuilder Interaction to judge the user's response as correct.

Feedback is displayed if the user answers correctly, incorrectly, or if the user responds in an unknown way, for 

example, if the user clicks Submit before matching any drag elements with a target.

Drag_2wayManyToMany: one-to-one matching (either way)

Places six drag & target elements on the page. A drag & target element can be both a drag element and a target element. 

Each drag & target element is the correct match for only one other drag & target element. 



35USING ADOBE ELEARNING SUITE COURSEBUILDER EXTENSION

Drag-and-Drop CourseBuilder Interactions

Last updated 4/1/2011

Because this interaction contains several drag-target pairs, the CourseBuilder Interaction is set up to judge a user's 

response when the user clicks Submit. When there is a single drag-target pair, it is more efficient to have the 

CourseBuilder Interaction judge the interaction as soon as the user drops the element. A user must match all three 

pairs correctly for the CourseBuilder Interaction to judge the user's response as correct.

Feedback is displayed if the user answers correctly, incorrectly, or if the user responds in an unknown way (for 

example, if the user clicks Submit before matching any drag elements with a target). 

Drag_1ToMany: one-to-many matching

Places one drag element and three target elements on the page. Only one of the target elements is the correct match for 

the drag element. The CourseBuilder Interaction judges the interaction as soon as the user drops the element.

Feedback is displayed if the user answers correctly, incorrectly, or if the user responds in a way that cannot be 

evaluated.

Drag_2way1ToMany: one-to-many matching (either way)

Places four drag & target elements on the page. Only one pair of drag & target elements constitute the correct match. 

The CourseBuilder Interaction judges the interaction as soon as the user drops an element.

Feedback is displayed if the user answers correctly, incorrectly, or if the user responds in an unknown way.

Drag_2way1To1 

The "Build your own" template is nothing more than a starting point that you can use to build your own drag-and-

drop CourseBuilder Interaction. You can use any of the templates as the starting point for a custom CourseBuilder 

Interaction. The virtue of this template is that it contains almost nothing, so you need not spend time deleting elements 

you do not use.

The template contains two drag & target elements. A drag & target element can be both a drag element and a target 

element. Neither method of matching the two elements—dragging the first to the second or dragging the second to the 

first—is considered correct or incorrect; both are unjudged.

The CourseBuilder Interaction is set up to judge the interaction as soon as the user drops one of the elements.

The CourseBuilder Interaction displays different feedback depending on whether the user drags the first element to 

the second or the second element to the first.

Drag_2StepInOrder: two-step procedure

The template contains one drag element and two target elements. Because this interaction has two steps, the 

CourseBuilder Interaction is set up to judge the interaction as soon as the user drops the drag element on one of the 

targets. The user drags the drag element twice—once for each step—so that the CourseBuilder Interaction judges the 

interaction twice.

Neither target element is considered a correct or incorrect match; both pairings are unjudged. The Action Manager, 

however, is set up to make sure that a user completes step 1 (matching the drag element with the first target element) 

before completing step 2 (matching the drag element with the second target element).

The Action Manager displays the appropriate feedback at the end of each step, indicating whether the user performed 

the steps in the correct sequence.
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Drag_2Steps1ToMany: two-step procedure with distractor

Places one drag element and three target elements on the page. The first drag element should be dropped on one target 

element, and then on another target element, in two separate steps. The third target element is part of an incorrect 

drag-target pair; if the user drops the drag element onto the target, the interaction displays a feedback message to alert 

the user that the response was incorrect. 

The template for a two-step procedure with a distractor contains one drag element and three target elements. 

Because this interaction has two steps, the CourseBuilder Interaction is set up to judge the interaction as soon as the 

user drops the drag element on one of the targets. The CourseBuilder Interaction judges the interaction each time the 

user drops the drag element on a target.

None of the target elements is considered a correct or incorrect match; all three pairings are unjudged. The Action 

Manager, however, is set up to make sure that a user completes step 1 (matching the drag element with the first target 

element) before completing step 2 (matching the drag element with the second target element). It also makes sure that 

the user drops the drag element on the correct target in step 2. 

The Action Manager displays the appropriate feedback at the end of each step, indicating whether the user performed 

the correct step and in the correct sequence.

The drag-and-drop CourseBuilder Interaction options

General tab

Field Description

Interaction Name Unique name of the interaction.

Judge 

Interaction

Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager.

• When the user clicks a button labeled ____: Adds an HTML form button to the page. The Interaction starts the 

evaluation when that button is clicked. 

• When the user drops a Drag Element

• On a specific event (set using the Judge Interaction Behavior): Starts the evaluation when some other action 

associated with the CourseBuilder Interaction occurs. Use either the Dreamweaver Behavior inspector or the 

Action Manager CourseBuilder Interaction to define the Judge Interaction action that initiates the evaluation. 

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you have 

one installed. When you check this option, a Tracking tab appears where you enter more information about 

scoring for the CourseBuilder Interaction.

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as 

correct within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct if 

the response corresponds to any of the correct answers.

•  All Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct 

only if the response corresponds to all of the correct answers.

Time Is Determines the amount of time in seconds that the user has to complete the interaction. Use the Action Manager 

to define or edit the actions that occur when time runs out.

Time Are Determines the number of tries a user has to complete the interaction. Use the Action Manager to define or edit 

the actions that occur when the user exhausts the number of tries. 
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Pairs tab

The Pairs tab, which is visible whenever you create or edit a drag-and-drop CourseBuilder Interaction, defines the 

CourseBuilder Interaction's drag & target pairs and any properties that apply to them.

Action Manager Tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions if a user:

• Reaches a time limit that you set on the General tab

Reset Create a Reset HTML form button.

DIV Places the interaction in its own DIV, allowing for absolute placement of the CourseBuilder Interaction on the 

page.

Reaction Determines what happens to a drag element when a user drops it on or near a target.

• Snap back if incorrect: Returns the drag element to its original position if the user drops it on an incorrect target.

• Snap back if not dropped on target: Returns the drag element to its original position if the user does not drop 

it on any of the possible target elements.

The CourseBuilder Interaction does not evaluate the Action Manager, even if you have selected "when the user 

drops a drag element" as the Judge Interaction setting.

Field Description

Pairs Contains an entry for each of the drag & target pairs defined. It also provides information on how the pair has to be 

judged. The pop-up menu (above the list) lists all of the possible drag & target pairs that do not yet appear on the 

Pairs list.

Add/Delete • Add: Adds the drag & target pair you have selected for the pop-up menu to the Pairs list.

• Delete: Removes the selected entry from the list.

Snap If Within 

__ pixels of the 

target element's 

center

Moves a drag element to the nearest possible target (regardless of how that drag & target pair is judged) if the user 

drops the drag element within the specified number of pixels of the target. The pixel value must be between 0 and 

9999. 

Snap To: 

Center/Left/Rig

ht/Top/Bottom 

of target 

element

Aligns the drag element with the target element. Alignment is based on the centers and edges of the layers that the 

drag and target elements occupy, not on the centers and edges of the drag and target graphics. If a graphic and the 

layer it occupies are of different sizes, their centers and edges might not correspond.

Snap To: __ 

pixels down, __ 

pixels to right of 

targetelement's 

upper left 

corner

Aligns the upper left corners of the layers that contain the drag and target elements, offsetting the corners by the 

values you enter. The pixel values must be between -999 and 9999. Alignment is based on the corners of the layers 

that the drag and target elements occupy, not on the corners of the drag and target graphics. If a graphic and the 

layer it occupies are of different sizes, their corners might not correspond. 

Choice Is: 

Correct/Incorrec

t/Not Judged

Defines the selected drag & target pair as correct, incorrect, or not judged. How the pair is judged determines the 

type of feedback the user receives when dropping the selected drag element onto the selected target. 

Score Score assigns a score to the pair. The score is passed to a management system for tracking, or called and displayed 

through custom JavaScript. For incorrect answers, you can penalize the learner through negative scoring.

Field Description
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• Response is correct, incorrect, or unknown

• Reaches the number of tries that you have set on the General tab

• Drags a given drag element in a procedural exercise

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. The settings on 

the Tracking tab specify interaction properties that may be recorded by a CMI or database server application. Use 

JavaScript variables to check the current value of these properties.

Elements tab

The Elements tab defines the individual drag elements and target elements in an interaction and any properties that 

apply to them.

One-to-one and one-to-many matching

Creating a matching exercise

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction category list, select Drag and Drop.

3 In the template gallery, select the icon for the type of matching exercise you want to create.

4 Replace the placeholder graphics with the images you want to use.

5 Click the Pairs tab, and set which pairs are correct and which are incorrect.

6 Click OK.

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight An optional setting to indicate the relative importance of the interaction. CMI systems may use the value of this 

property for scoring and grading students. 

Field Description

Elements Contains an entry for each of the drag-and-drop elements in the CourseBuilder Interaction, along with 

information about whether those elements are drag elements, target elements, or both drag and target 

elements.

Name The name of the selected element. The name is case-sensitive and cannot be reused for another element. All 

characters must be alphanumeric, and the name cannot contain spaces.

Name Image File Name of the image file used for the selected element. The template supplies a placeholder. You can replace the 

graphic if necessary.

Element Is Defines what role the current drag-and-drop element plays. A drag element is the element that the user moves; 

a target element is the element that the drag element is dropped on; and an element that is both drag and 

target can be both dragged to and dropped on by other elements.
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7 Replace the default text that appears above the interaction in the document. Change the positions of the DIVs to 

rearrange the graphics.

Building your own matching exercise

Add the template to the document:

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction category list, select Drag and Drop.

3 In the template gallery, select the "Build your own" icon.

Check the settings:

1 Click the General tab.

2 Do either of the following to select the Judge Interaction setting:

• To judge a user's response after dragging a single element to a target, select "when the user drops a drag element".

• To judge a user's response after two or more elements are dragged to their targets, select "when the user clicks a 

button labeled Submit".

3 Decide what must happen when a user drops a drag element, and select the appropriate Reaction options.

Add the elements you need:

1 Click the Elements tab.

2 Add the elements you need.

3 Replace the placeholder graphics with the images you want to use.

4 Decide which elements you want to be drag elements, which you want to be target elements, and which, if any, you 

want to be both.

Set up the pairs of elements that match:

1 Click the Pairs tab.

2 Add all the pairs of elements that are valid matches.

3 For each pair, set up the target's active area and the position you want the drag element to snap to when it is 

dropped.

4 Mark each pair as correct, incorrect, or not judged.

5 If you are tracking performance, assign each pair a score.

Set up the Action Manager:

1 Click the Action Manager tab.

2 Think through how you want the interaction to work, and translate that behavior into conditions and actions.

3 After you make changes, click OK.

Finish and test the exercise:

1 Replace the default text that appears above the interaction in the document. Change the positions of the DIVs to 

rearrange the graphics.

2 Test the exercise thoroughly to make sure that it works as you want.
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Creating two-step procedures

Creating a procedure

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction category list, select Drag and Drop.

3 In the template gallery, select the icon for the type of procedure (Two-step procedure or Two-step procedure with 

distractor).

4 Replace the placeholder graphics with the images you want to use.

5 Click OK.

6 Replace the default text that appears above the interaction in the document. Rearrange the positions of the graphics 

if you need.

Building your own procedure

Add a two-step procedure template to the document:

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction category list, select Drag and Drop.

3 In the template gallery, select one of the procedure templates and use it as the starting point for your custom 

CourseBuilder Interaction.

Check the settings:

1 Click the General tab.

2 Select a Judge Interaction setting by doing one of the following:

• To judge a user's response after dragging a single element to a target, select "when the user drops a drag element".

• To judge a user's response after dragging two or more elements to their targets, select "when the user clicks a 

button labeled Submit".

3 Decide what must happen when a user drops a drag element, and select the appropriate Reaction options.

Add the elements you need:

1 Click the Elements tab.

2 Add the elements you need.

3 Replace the placeholder graphics with the images you want to use.

4 Decide which elements you want to be drag elements, which you want to be target elements, and which, if any, you 

want to be both.

Set up the pairs of elements that match:

1 Click the Pairs tab.

2 Add all the pairs of elements that are valid matches.

3 For each pair, set up the target's active area and the position you want the drag element to snap to when it is 

dropped.

4 Mark each pair as correct, incorrect, or not judged.

5 If you are tracking performance, assign each pair a score.
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Set up the Action Manager:

1 Click the Action Manager tab.

2 Think through how you want the interaction to work and translate that behavior into conditions and actions.

3 When you make changes, click OK.

Finish and test the procedure:

1 Replace the default text that appears above the interaction in the document. Rearrange the positions of the graphics 

if you need.

2 Test the procedure thoroughly to make sure that  it works as you want.

Editing drag-and-drop procedures

Naming a drag-and-drop element

The templates assign default names (drag1, target1, and so on) to each choice. Giving an element a more descriptive name 

makes it easier to work with. The name you give an element appears only in the CourseBuilder Interaction dialog box.

To change the name, in the Elements tab, select the name of the element you want to change and replace it. Names can 

contain only letters and numbers.

Adding and deleting drag-and-drop elements

Delete an element

In the Elements tab, go to Elements list, select the name of the element you want to delete and then click Delete.

The element is deleted from the Elements list. References to the element are also deleted from the Pairs and Action 

Manager tabs.

Add an element

1 In the Elements tab, go to Elements list and select the name of the element whose properties are most like the one 

you want to add.

2 Click Add.

The element is duplicated.

3 Name the element, modify the properties that need changes, and add the pairs associated with the new element.

Adding and deleting drag-and-drop pairs

Delete a pair

In the Pairs tab, go to Pairs list, select the name of the pair you want to delete, and then click Delete.

The pair is deleted from the Pairs list. The pair is also deleted from the Action Manager tab along with any feedback 

settings included for the pair.

Add a pair

1 Choose an existing pair to duplicate by selecting one in the Pairs pop-up menu or in the Pairs list.

2 Click Add.
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A new pair is created which has the same pair options as the pair you selected.

3 Modify the options that need changes. 

4 Click OK to close the dialog box.

A target's active area

A target element has an active area surrounding it that determines whether an element dropped near it has hit the 

target. The Snap If Within setting on the Pairs tab determines how large the active area is. The active area is a circle 

measured from the center of the layer the target element occupies. Because the target area is measured from the center 

of the layer, rather than the center of the graphic that represents the target element, the active area may not correspond 

exactly to the graphic if the layer and the graphic are different sizes.

A drag element is considered to be inside the active area if the center of the layer the drag element occupies is inside 

the circle that defines the active area. The position of the pointer does not matter; it can be inside or outside the active 

area. If the graphic that represents the drag element and the layer it occupies are of different sizes, their centers will not 

correspond. If the center of the drag graphic is inside the active area, but the center of the drag layer is not, then the 

drag element has not hit the target. On the other hand, if the center of the drag layer is inside the active area, the drag 

element has hit the target—even if the center of the drag graphic is outside the active area.

The active area of placeholder targets

The layer that each placeholder target occupies is 96 pixels square. The active area of each placeholder target (set on 

the Pairs tab) has a radius of 75 pixels. That means the active area extends 27 pixels beyond the left, right, top, and 

bottom edges of the target layer.

The active area is measured from the center of the target layer and not the center of the graphic that occupies the layer. 

If you replace the placeholder graphic with an image that is larger or smaller, you have to adjust both the size of the 

layer and the radius of the active area.

Setting how an element behaves when dropped

Set the size of a target's active area:

1 In the CourseBuilder Interaction dialog box, click the Pairs tab.

2 In the Snap If Within field, type the size (in pixels) of the circle that defines the target element's active area.

The CourseBuilder Interaction uses the number you type as the radius of the circle—the distance from the circle's 

center to its edge.

Set what happens when a dropped element misses the target:

1 Click the General tab.

2 Select a Reaction option:

• To return the drag element to its original position, select "Snap back if not dropped on target".

• To leave the drag element where the user has dropped it, deselect "Snap back if not dropped on target".

Set what happens when an element is dropped on the wrong target:

1 Click the General tab.

2 Select a Reaction option:

• To return the drag element to its original position, select "Snap back if incorrect".

• To snap the drag element to the target, deselect "Snap back if incorrect".
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Set where the dropped element snaps:

1 Click the Pairs tab.

2 Select a Snap To option:

• To center the dropped element over the target or to align it with the target's left, right, top, or bottom edge, select 

the first Snap To option and then select the setting you want from the pop-up menu.

• To position the dropped element more precisely, select the second Snap To option and enter pixel values in the 

two fields.

Making an element a drag element or a target

Set an element as a drag or target element:

1 In the CourseBuilder Interaction dialog box, click the Elements tab.

2 In the Element Is pop-up menu, select:

• Drag Element to allow users to drag the element

• Target Element to make the element a target

• Both Drag and Target to allow users to drag the element and to allow the element to work as a target as well.



44

Last updated 4/1/2011

Chapter 6: Matching Interactions

Matching Interactions overview

CourseBuilder Matching Interactions require users to match a set of question statements with their answers. Although 

multiple questions can have the same answer, each question can have only one answer.

Use the matching interaction to have students demonstrate their understanding of concepts, terms, and complex 

relationships between objects. For examples, students can match cities with their countries. More than one city may 

belong to the same country, but each city can belong to only one country.

Matching templates

Drag and Drop Type matching interaction

Lets the user drag and drop questions onto their correct answers. Multiple questions can have the same answer. 

However, each question can have only one answer.

Combo Type matching interaction

Lets the user select the combo box pertaining to the correct answer for a question. Multiple questions can have the 

same answer. However, each question can have only one answer.

The CourseBuilder matching interaction options

General tab

Field Description

Interaction Name Unique name of the interaction.

Question Text The text of the question, statement, or instruction that precedes the choices.

Judge 

Interaction

Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager.

• When the user clicks a button labeled ____: Adds an HTML form button to the page. The CourseBuilder Interaction 

starts the evaluation when that button is clicked. 

• When the user selects an answer.

• On a specific event (set using the Judge Interaction Behavior): Starts the evaluation when some other action 

associated with the CourseBuilder Interaction occurs. Use either the Dreamweaver Behavior inspector or the 

Action Manager CourseBuilder Interaction to define the Judge Interaction action that initiates the evaluation.

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you have one 

installed. When you check this option, a Tracking tab appears where you enter more information about scoring for 

the CourseBuilder Interaction. 
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Pairs tab

The Pairs tab, which is visible whenever you create or edit a drag-and-drop CourseBuilder Interaction, defines the 

CourseBuilder Interaction's drag & target pairs and any properties that apply to them.

Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions when a user:

• Reaches a time limit that you have set on the General tab

• Response is correct, incorrect, or unknown

• Reaches the tries limit that you have set on the General tab

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. The settings on 

the Tracking tab specify interaction properties that may be recorded by a CMI or database server application. Use 

JavaScript variables to check the current value of these properties.

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as correct 

within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct if 

the response corresponds to any of the correct answers.

•  All Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct only 

if the response corresponds to all of the correct answers.

Time Is Determines the amount of time in seconds that the user has to complete the interaction. Use the Action Manager to 

define or edit the actions that occur when time runs out.

Tries Are Determines the number of tries a user has to complete the interaction. Use the Action Manager to define or edit the 

actions that occur when the user exhausts the number of tries. 

Reset Adds an HTML form button to the CourseBuilder Interaction to clear user input during the interaction. Clicking Reset 

or refreshing the page in the browser window does not, however, deselect any selected radio buttons in a multiple-

choice CourseBuilder Interaction. 

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder Interaction 

on the page. 

Field Description

Pairs Lists combinations of question and answer elements as matching pairs. Use the buttons to add and delete pairs.

Score The value assigned to a pair of an option and a pop-up menu. For incorrect answers, you can penalize the learner 

through negative scoring.

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight An optional setting to indicate the relative importance of the interaction. CMI systems may use the value of this 

property for scoring and grading students.

Field Description
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Elements tab

Working with Matching interactions

Naming a matching element 

Giving an element a more descriptive name makes it easier to work with. The name you give an element appears only 

in the CourseBuilder Interaction dialog box.

To change the name of an element:

1 In the Elements tab, go to Elements list and select the name of the element you want to change.

2 In the Name field, replace the default name with the name you want.

Names can contain only letters and numbers.

Adding and deleting question & answer pairs

Delete a pair:

In the Pairs tab, go to Pairs list, select the name of the pair you want to delete, and then click Delete.

The pair is deleted from the Pairs list. The pair is also deleted from the Action Manager tab along with any feedback 

settings included for the pair.

Add a pair:

1 In the Pairs tab, choose an existing pair to duplicate by selecting a pair in the Pairs pop-up menu or in the Pairs list.

2 Click Add.

A new pair is created which has the same pair options as the pair you selected.

3 Change any options that need modification.

4 Click OK to close the dialog box.

Making an element a question or an answer

1 In the CourseBuilder Interaction dialog box, click the Elements tab.

2 Select an element type in the Element Is pop-up menu.

Field Description

Elements Lists all of the elements in the CourseBuilder Interaction. Use the buttons to add and delete elements.

Name Name of the selected element. 

Element Is Defines the selected element as a drag element, a target element, or a drag & target element.

Text Defines the actual text that is displayed for the selected element.

Add/Delete Used to add new elements or delete selected matching elements
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Chapter 7: Sequence Interactions

Overview of the Sequence Interaction

CourseBuilder Sequence Interactions require the learner to identify the logical order for the members of a list. For 

example, learners may be required to decide the correct order of phrases in a jumbled sentence. Students use pop-up 

menus to indicate the correct order of the members of the list.

Consider the following jumbled sentence for example:

[in the solar system][the largest planet] [Jupiter is].

Learners can reorder the three phrases in their correct order:

[Jupiter is][the largest planet][in the solar system].

Creating a CourseBuilder sequence interaction

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the template gallery, select the sequence template.

3 Click OK.

The CourseBuilder sequence interaction options

General tab

Field Description

Interaction Name Unique name of the interaction.

Question Text The text of the question, statement, or instruction that precedes the choices.

Judge 

Interaction

Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager. 

•  When the user clicks a button labeled ____: Adds an HTML form button to the page. The CourseBuilder Interaction 

starts the evaluation when that button is clicked. 

• When the user selects an answer

• On a specific event (set using the Judge Interaction Behavior): Starts the evaluation when some other action 

associated with the CourseBuilder Interaction occurs. Use either the Dreamweaver Behavior inspector or the 

Action Manager CourseBuilder Interaction to define the Judge Interaction action that initiates the evaluation.

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as correct 

within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct if 

the response corresponds to any of the correct answers.

• All Correct and None Incorrect causes CourseBuilder to judge a user's response to the interaction as correct only 

if the response corresponds to all of the correct answers. 
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Pairs tab

The Pairs tab, which is visible whenever you create or edit a drag-and-drop CourseBuilder Interaction, defines the 

CourseBuilder Interaction's drag & target pairs and any properties that apply to them.

Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions if a user:

• Reaches a time limit that you have set on the General tab

• Response is correct, incorrect, or unknown 

• Reaches the number of tries set on the General tab

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. The settings on 

the Tracking tab specify interaction properties that may be recorded by a CMI or database server application. Use 

JavaScript variables to check the current value of these properties.

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you have one 

installed. When you check this option, a Tracking tab appears where you enter more information about scoring for 

the CourseBuilder Interaction. 

Tries Are Determines the number of tries a user has to complete the interaction. Use the Action Manager to define or edit the 

actions that occur when the user exhausts the number of tries.

Time Is Determines the amount of time in seconds that the user has to complete the interaction. Use the Action Manager to 

define or edit the actions that occur when time runs out. 

Reset Adds an HTML form button to the CourseBuilder Interaction to clear user input during the interaction. Clicking Reset 

or refreshing the page in the browser window does not, however, deselect any selected radio buttons in a multiple-

choice CourseBuilder Interaction.

Field Description

Pairs Lists combinations of options and pop-up menus. Use the buttons to add and delete pairs.

Choice Is Determines whether a pop-up menu option has been correctly mapped to an element.

Score Value assigned to a pair of an option and a pop-up menu. For incorrect answers, you can penalize the 

learner through negative scoring.

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight An optional setting to indicate the relative importance of the interaction. CMI systems may use the value of this 

property for scoring and grading students. 

Field Description
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Elements tab

Combo tab

Field Description

Elements Lists all of the elements in the CourseBuilder Interaction. Use the buttons to add and delete elements.

Name Name of the selected element.

Text Defines the actual text that is displayed for the selected element.

Field Description

Elements Lists all of the options in the CourseBuilder Interaction pop-up menus. Use the relevant buttons to add and 

delete elements.

Name Name of the selected element.
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Chapter 8: Explore CourseBuilder 
Interactions

Explore interactions overview

Use the Explore CourseBuilder interaction to let users explore an on-screen object by clicking its hot areas. For 

example, students can explore hot areas with information on specific parts of a graphically represented object or 

concept.

The explore CourseBuilder interaction contains one or more clickable hot areas that initiate pre-defined actions when 

clicked. The hot areas can contain images or text, or remain empty and invisible.

The explore CourseBuilder Interaction can also include a backdrop image file on which the hot areas sit.

The explore templates

You can choose from three explore CourseBuilder Interaction templates:

Explore_Transparent: random exploration (transparent)

Use to create explore exercises of objects, processes, or concepts whose parts can be examined in any order. Contains 

a background image and five transparent hot areas.

Explore_Random: random exploration

Use to create explore exercises of objects, processes, or concepts whose parts can be examined in any order. Contains 

a background image and five hot areas containing placeholder graphics.

Explore_Areas: structured exploration

Use to create explore exercises of objects, processes, or concepts whose parts are best examined in a particular order. 

Contains four hot areas containing placeholder graphics.

Creating Explorations

Random exploration

The two random exploration templates are ideal for interactions that allow users to explore the parts of objects, 

processes, or concepts in any order.

The random exploration templates contain a background image and five hot areas containing placeholder graphics. 

The placeholder graphics are transparent in one version of the template.

All of the hot areas are not judged. The CourseBuilder Interaction judges a user's response every time the user clicks a 

hot area. The CourseBuilder interaction displays feedback for each hot area a user clicks.

Creating a random exploration

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).
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2 In the CourseBuilder Interaction category list, select Explore.

3 In the template gallery, select the random exploration icon.

4 Replace the placeholder graphics with the images you want to use.

5 Add more hot areas, or delete hot areas you do not need.

6 Click OK.

7 In the Dreamweaver document, align the hot area DIVs with the background image.

8 Replace the default instructions that appear above the images.

Structured exploration

The structured exploration template is ideal for creating explorations of objects, processes, or concepts whose parts are 

best examined in a particular order.

The structured exploration template contains four hot areas containing placeholder graphics.

All of the hot areas are not judged. The CourseBuilder Interaction judges a user's response every time the user clicks a 

hot area. The CourseBuilder Interaction displays feedback for each hot area a user clicks.

Creating a structured exploration

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the CourseBuilder Interaction category list, select Explore.

3 In the template gallery, select the structured exploration icon.

4 Replace the placeholder graphics with the images you want to use.

5 Click OK.

6 In the Dreamweaver document, align the hot area DIVs.

7 Replace the default instructions that appear above the images.

The explore CourseBuilder interaction options

General tab

Field Description

Interaction Name Unique name of the interaction.

Judge 

Interaction

Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager.

•  When the user clicks a button labeled ____: Adds an HTML form button to the page. The CourseBuilder 

Interaction starts the evaluation when that button is clicked. 

•  When the user clicks a hot area: Starts the evaluation whenever the user clicks one of the CourseBuilder 

Interaction's hot areas.

• On a specific event (set using the Judge Interaction Behavior): Starts the evaluation when some other action 

associated with the CourseBuilder Interaction occurs. Use either the Dreamweaver Behavior inspector or the 

Action Manager CourseBuilder Interaction to define the Judge Interaction action that initiates the evaluation. 

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you have 

one installed. When you check this option, a Tracking tab appears where you enter more information about 

scoring for the CourseBuilder Interaction.
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Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions if a user:

• Reaches a time limit that you have set on the General tab

• Clicks a given hot area 

• Response is correct, incorrect, or unknown

• Reaches the number of tries that you have set on the General tab

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. This tab applies 

to all interactions. The settings on the Tracking tab specify interaction properties that may be recorded by a CMI or 

database server application. Use JavaScript variables to check the current value of these properties.

Hot Areas tab

The Hot Areas tab defines the individual hot area DIVs in an explore interaction and any properties that apply to them.

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as 

correct within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct 

if the response corresponds to any of the correct answers.

•  All Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct 

only if the response corresponds to all of the correct answers.

Time Is Determines the amount of time in seconds that the user has to complete the interaction. Use the Action Manager 

to define or edit the actions that occur when time runs out.

Tries Are Determines the number of tries a user has to complete the interaction. Use the Action Manager to define or edit 

the actions that occur when the user exhausts the number of tries. 

Reset Create a Reset button for this Interaction adds an HTML form button to the CourseBuilder Interaction to clear 

user input during the interaction. Clicking the Reset or refreshing the page in the browser window does not, 

however, deselect any selected radio buttons in a multiple-choice CourseBuilder Interaction.

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder 

Interaction on the page. 

Background 

Image File

Name of the file name of an image behind the hot areas. 

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight An optional setting to indicate the relative importance of the interaction. CMI systems may use the value 

of this property for scoring and grading students. 

Field Description
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Editing explore interactions

Replacing placeholder graphics

Replace the background image in an explore interaction:

❖ In the General tab, go to the Background Image File field, click Browse, then navigate to and select the image file 

you want to use in place of the placeholder background graphic.

Replace the hot area graphics in an explore interaction:

1 In the Hot Areas tab, go to the Hot Areas list, select the hot area that's associated with the placeholder graphic you 

want to replace.

2 Click the Browse button (next to the Image field), and select the image file you want to use in place of the 

placeholder graphic.

Replace any placeholder image directly in a document:

1 Double-click the placeholder graphic.

2 In the dialog box that appears, locate the image file you want to use and open it.

Naming a hot area

The templates assign default names (HotArea1, HotArea2, and so on) to each hot area. Giving a hot area a more 

descriptive name makes it easier to work with. The name you give a hot area appears only in the CourseBuilder 

Interaction dialog box.

Change the name of a hot area:

1 In the Hot Areas tab, go to the Hot Areas list and select the name of the hot area you want to change.

2 In the Name field, replace the default name with the name you want.

Adding text to a hot area

Add text to a hot area to identify for users what the hot area represents. The text you add appears with the hot area on 

the page.

Field Description

Hot Areas Lists all of the hot areas in the CourseBuilder Interaction. Use the buttons to add and delete hot areas.

Name Labels the current hot area DIV. The name is case sensitive and cannot be reused for another hot area. All 

characters must be alphanumeric, and the name cannot contain spaces.

Text The text that is displayed on the page with the selected hot area. 

Image Name of the image file that contains the selected hot area's graphic. 

Hot Area Is Defines the current hot area DIV as correct, incorrect, or not judged. How the hot area is judged determines 

the type of feedback the user receives when clicking that hot area..

Score Value assigned to choosing the hot area. The score is passed to a management system for tracking or called 

and displayed through custom JavaScript.
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Add text to a hot area:

1 In the Hot Areas tab, select Hot Areas list and select the name of the hot area you want to add text to.

2 In the Text field, type the text you want to add.

After you close the dialog box, use the commands on the Text menu to modify the appearance of the text.

Adding and deleting hot areas

Delete a hot area:

❖ In the Hot Areas tab, go to Hot Areas list and select the name of the hot area you want to delete; then click Delete.

Add a hot area:

1 In the Hot Areas tab, go to the Hot Areas list and select the name of the hot area whose properties are most like the 

one you want to add.

2 Click Add.

CourseBuilder for Dreamweaver duplicates the hot area.

3 Name the hot area.

4 Change the properties that need changing.

5 Replace the placeholder image with the image you want to use.
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Chapter 9: Text Entry CourseBuilder 
Interactions

Text Entry Interaction overview

These CourseBuilder Interactions gather brief text responses—either words or phrases—from the user. For example, 

you can use this CourseBuilder Interaction to create fill-in-the-blank exercises.

You can also use a text entry CourseBuilder Interaction to have the student show mastery of subject matter. Text entry 

interactions are useful for determining whether students are retaining the information from a tutorial or presentation 

rather than just recalling a correct response from its remembered position.

The text entry CourseBuilder Interaction displays a single- or multiple-line HTML text input box that accepts either 

plain or password-encrypted text. Text that the user types in the box is compared against characters or strings (called 

possible responses) defined for the CourseBuilder Interaction. When user input matches one of the defined strings, 

actions occur—depending on whether you have designated the string as correct, incorrect, or not judged.

The text entry templates

You can choose from two text entry CourseBuilder Interaction templates, and then use the tabs on the CourseBuilder 

Interaction dialog box to customize the text entry interaction:

Text_Singleline: single-line text entry

Places an empty text field on the page, along with a Submit button and a Reset button. The template is set up with three 

possible responses. The first response is correct; the other two responses are incorrect.

Capitalization is ignored, but otherwise the user must type exactly the text of the response for the CourseBuilder 

Interaction to consider the user's response a match. Any response that does not match one of the three possible 

responses is not judged. The CourseBuilder Interaction judges a user's response when the user clicks Submit.

A user can clear the field either before or after clicking the Submit button by using the Reset button. The CourseBuilder 

Interaction displays feedback if the user answers correctly, incorrectly, or if the user types something other than one 

of the three possible responses.

Text_Multiline: multiple-line text entry

Places an empty text area on the page. The multiple-line text entry template places an empty text box on the page, along 

with a Submit button and a Reset button. The template is set up with three possible responses. The first response is 

correct; the other two responses are incorrect.

Capitalization is ignored. The CourseBuilder Interaction considers the user's response a match if it contains the text 

of one of the possible responses. Any response that does not match one of the three possible responses is not judged. 

The CourseBuilder Interaction judges a user's response when the user clicks Submit. A user can clear the field either 

before or after clicking Submit using the Reset button. The CourseBuilder Interaction displays feedback if the user 

answers correctly, incorrectly, or if the user types something other than one of the three possible responses in the 

Correctness segment in the Action Manager tab.
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Creating a text entry field

1 Insert a CourseBuilder Interaction in the document (Insert > CourseBuilder Interaction).

2 In the Category section, select Text Entry.

3 In the template gallery, select the text entry icon you want to use.

4 Click the Responses tab, select the first response in the Possible Responses section, and then type the text of the 

correct answer in the Must Contain field. Repeat for each of the wrong answers.

• If the answers are neither right nor wrong, see“Marking a response right or wrong” on page 109.

• If you want to delete default responses or add additional ones, see “Adding and deleting responses” on page 58.

5 Click OK.

6 Replace the placeholder text above the text field with a question or instructions.

The Text Entry CourseBuilder Interaction options

General tab

Field Description

Interaction Name Unique name of the interaction.

Judge 

Interaction

Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager. 

• When the user clicks a button labeled ____: Adds an HTML form button to the page. The CourseBuilder 

Interaction starts the evaluation when that button is clicked. 

• When the user clicks or tabs out of the text entry field.

• On a specific event (set using the Judge Interaction Behavior): Starts the evaluation when some other action 

associated with the CourseBuilder Interaction occurs. Use either the Dreamweaver Behavior inspector or the 

Action Manager CourseBuilder Interaction to define the Judge Interaction action that initiates the evaluation.

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as 

correct within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct 

if the response corresponds to any of the correct answers.

•  All Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct 

only if the response corresponds to all of the correct answers.

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you have 

one installed. When you check this option, a Tracking tab appears where you enter more information about 

scoring for the CourseBuilder Interaction.

Tries Are Determines the number of tries a user has to complete the interaction. Use the Action Manager to define or edit 

the actions that occur when the user exhausts the number of tries.

Time Is Determines the amount of time in seconds that the user has to complete the interaction. Use the Action Manager 

to define or edit the actions that occur when time runs out.
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Action Manager Tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions if a user:

• Reaches a time limit that you have set on the General tab

• Response is correct, incorrect, or unknown

• Reaches the number of tries that you have set on the General tab 

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. This tab applies 

to all interactions. The settings on the Tracking tab specify interaction properties that may be recorded by a CMI or 

database server application. Use JavaScript variables to check the current value of these properties.

Responses tab

The Responses tab, defines strings of text (called possible responses) for user input to be compared to, as well as any 

properties that apply to those strings. Possible responses can be either correct or incorrect—they are simply strings of 

text you expect users to enter.

Reset Adds an HTML form button to the CourseBuilder Interaction to clear user input during the interaction. Clicking 

Reset or refreshing the page in the browser window does not, however, deselect any selected radio buttons in a 

multiple-choice CourseBuilder Interaction.

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder 

Interaction on the page. 

Initial text Default text that appears in the text entry field and that the user can replace. 

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight An optional setting to indicate the relative importance of the interaction. CMI systems may use the value 

of this property for scoring and grading students.

Field Description

Possible 

Responses

Contains an entry for each text string you expect users to enter. It also contains, for each entry, information 

about how user input is judged if it matches the current response.

Name Labels the current response. The name of a response is different from the text you expect users to enter. The 

name of the choice appears only in the CourseBuilder Interaction dialog box; it is merely a way of labeling a 

response to make it easier to work with. The name is case sensitive and cannot be reused for another response. 

All characters must be alphanumeric, and the name cannot contain spaces. 

Must Contain  Defines the character or string of characters that you expect users to enter. The user's actual input is compared 

to the character or string. If it matches, it is judged based on whether you have defined the text response as 

correct, incorrect, or not judged. 

Case Sensitive Requires that the user's capitalization matches the capitalization in the Must Contain field. 

Exact match 

required

Considers the user's input a match only if the text the user has entered is the same as the text in the Must 

Contain field in every way—the same spelling, same spacing, and same punctuation. Only the capitalization 

can vary. If this option is unselected, the CourseBuilder Interaction considers the user's input a match if the text 

in the Must Contain field appears somewhere in the text the user has typed. 

Field Description
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Working with text entry CourseBuilder Interaction

Adding default text to a field

If most users supply the same information in a text field, provide that information as the default. Or give users an 

example of the format in which they should enter information. For example, display mm/dd/yyyy in a date field.

Add default text to a field:

1 Open the CourseBuilder Interaction dialog box, then click the General tab.

2 In the Initial Text field, type the text you want the CourseBuilder Interaction to display in the text entry field.

Naming a response

The templates assign default names (Response1, Response2, and so on) to each possible response. The name of a 

response is different from the text you expect users to enter. The name of the choice appears only in the CourseBuilder 

Interaction dialog box; it is merely a way of labeling a response to make it easier to work with.

Change the name of a response:

1 Open the CourseBuilder Interaction dialog box, then click the Responses tab.

2 In the Possible Responses list at the top of the tab, select the name of the response you want to change.

3 In the Name field, replace the default name.

Adding and deleting responses

Delete a response:

In the Responses tab, go to Possible Responses, select the name of the response you want to delete, then click Delete.

Add a response:

1 In the Responses tab, go to Possible Responses, select the name of the response whose properties are most like the 

one you want to add.

2 Click Add.

CourseBuilder for Dreamweaver duplicates the response.

3 Name the response.

4 Modify the properties that need changing.

Match Is Defines user input, if it matches the current possible response character or string, as correct, incorrect, or not 

judged. How the character or string is judged determines the type of feedback the user receives when entering 

that text. 

Score  The value assigned to the response. The score is passed to a management system for tracking or called and 

displayed through custom JavaScript. 

Any Other 

Response Is 

Determines whether any response other than those explicitly defined is right or wrong.

Field Description
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Checking for correct capitalization

Correct capitalization means that the text a user types is capitalized exactly as the text in the Must Contain field.

Accept an entry as a match only if it is capitalized correctly:

1 In the Responses tab, go to Possible Responses field, and then select the response you want to check for correct 

capitalization.

2 Select the Case Sensitive option.

Checking for an exact match

An exact match means that the text a user types must be the same as the text in the Must Contain field—the same 

spelling, same spacing, and same punctuation. Only the capitalization may vary.

Accept only an exact match:

1 In the Responses tab, go to the Possible Responses field, then select the response you want to accept only if it is 

matched exactly.

2 Select the Exact Match Required option.

Checking for key words or phrases

You may not care exactly what users type as long as what they type contains key words and phrases.

Accept text with key words and phrases as a match:

1 In the Responses tab, go to the Must Contain field, then type a key word or phrase.

2 Deselect the Exact Match Required option if it is selected.

3 Repeat steps 2 and 3 for each word or phrase you want to accept.

Checking for unanticipated responses

Some users may respond in ways you cannot anticipate. Expect the unanticipated, and set up the CourseBuilder 

Interaction to handle it.

Handle unanticipated responses:

❖ In the Responses tab, select an Any Other Response Is setting for any text that fails to match one of the responses 

you have defined:

• Correct: To treat unanticipated responses as correct. Displays the feedback triggered by the "if Correct" 

condition in the Correctness segment.

• Incorrect: To treat unanticipated responses as incorrect. Displays the feedback triggered by the "else if Incorrect" 

condition in the Correctness segment.

• Not Judged: To treat unanticipated responses as unknown. Displays the feedback triggered by the "else if 

Unknown Response" condition in the Correctness segment.
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Chapter 10: Likert Interactions

Likert Interaction overview

CourseBuilder Likert interactions require users to indicate their level of agreement with the statements presented.

Users can select one of the following options to respond to CourseBuilder Likert questionnaires:

Likert interactions find extensive use in psychometric assessment.

The Likert CourseBuilder Interaction options

General tab

Choices tab

The Choices tab, which appears whenever you create or edit a multiple-choice CourseBuilder Interaction, defines the 

individual choices in a multiple-choice interaction and any properties that apply to them.

1 Disagree

2 Somewhat Disagree

3 Somewhat Agree

4 Agree

Field Description

Interaction Name Unique name of the interaction.

Question Text The text of the question, statement, or instruction that precedes the choices.

Judge 

Interaction

Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager.

• When the user clicks a button labeled ____: Adds an HTML form button to the page. The CourseBuilder 

Interaction starts the evaluation when that button is clicked. 

• When the user selects an answer

• On a specific event (set using the Judge Interaction Behavior): Starts the evaluation when some other action 

associated with the CourseBuilder Interaction occurs. Use either the Dreamweaver Behavior inspector or the 

Action Manager CourseBuilder Interaction to define the Judge Interaction action that initiates the evaluation.

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you have 

one installed. When you check this option, a Tracking tab appears where you enter more information about 

scoring for the CourseBuilder Interaction. 

Time Is Determines the amount of time in seconds that the user has to complete the interaction. Use the Action Manager 

to define or edit the actions that occur when time runs out.

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder 

Interaction on the page.
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Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions when:

• A user reaches a time limit that you have set on the General tab

• A segment which indicates which of the choices is selected

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. This tab applies 

to all interactions. The settings on the Tracking tab specify interaction properties that may be recorded by a CMI or 

database server application. Use JavaScript variables to check the current value of these properties.

Adding or deleting a choice

Delete a choice:

Go to the Choices tab, and then in the Choices list, select the name of the choice you want to delete, then click Delete.

Add a choice:

1 In the Choices tab, go to the Choices list at the top of the tab and then select the name of the choice whose properties 

are most like the one you want to add.

Field Description

Choices Lists all the choices in the CourseBuilder Interaction. Use the buttons to add, delete, and rearrange choices. 

Name Identifies the selected choice. The name of a choice is different from the text of the choice. The text of a choice 

is what appears on the page; it is what the user sees. The name of the choice appears only in the CourseBuilder 

Interaction dialog box. The name is case sensitive and cannot be reused for another choice. All characters 

must be alphanumeric, and the name cannot contain spaces.

Text Adds the text you type in the field to the selected choice. Customize the text in the Dreamweaver document. 

For example, true.

Image File Name of an image file associated with the text of a choice.

Do not use this option for graphic buttons or check boxes or for graphics-only questions; use the Appearance 

option instead.

Appearance Name of an image file for a graphic button or check box.

Place before text Puts the image in front of all text when the current choice appears on the page. This option applies only to 

the selected choice and must be individually reapplied to other choices in the CourseBuilder Interaction.

Edit options Lets you add/edit, and move the choices up and down.

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight An optional setting to indicate the relative importance of the interaction. CMI systems may use the value 

of this property for scoring and grading students. 
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2 Click Add.

The choice is duplicated.

3 Name the choice.

4 Arrange the choice's position in the Choices list.
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Chapter 11: Enhancements and 
Customization

Enhancing and customizing CourseBuilder Interactions

CourseBuilder for Dreamweaver offers many ways to enhance and customize web-based learning interactions:

• Change the default feedback a CourseBuilder Interaction provides. Personalize feedback for each student. See 

“Customizing feedback” on page 64.

• Display feedback in a frame, DIV, window status bar, or text field instead of in a pop-up message. See “Displaying 

feedback in a frame, layer, status bar, or text field” on page 65.

• Limit the number of tries a user has to respond to an interaction correctly. See “Limiting the number of tries” on 

page 66.

• Limit the amount of time a user has to respond to an interaction correctly. See “Putting a time limit on an 

interaction” on page 66.

• Control the event that starts the evaluation of the Action Manager. See “Setting when a CourseBuilder Interaction 

is judged” on page 67.

• Give the Submit button a different label. See “Changing the name of the Submit button” on page 67.

• Add a button to a CourseBuilder Interaction so that a user can start the interaction over. See “Resetting a 

CourseBuilder Interaction” on page 68.

• Insert a CourseBuilder Interaction into a DIV. See “Inserting a CourseBuilder Interaction” on page 25.

• Change the default scripts and images folder, the tries and time limits used in the templates, the default labels on 

Submit and Reset buttons, and other standard settings. See “Setting preferences” on page 68.

• Save a CourseBuilder Interaction that you customized to the Gallery so you can use it as a template. See “Adding a 

CourseBuilder Interaction template to the Gallery” on page 69.

Editing CourseBuilder Interactions

Edit a CourseBuilder Interaction:

1 Select the CourseBuilder Interaction icon in the document.

2 Click Edit in the Property inspector.

The CourseBuilder Interaction dialog box appears.

3 Make whatever changes you want to the CourseBuilder Interaction, then click OK.

Cutting, copying, pasting, and clearing interactions

Use the Cut, Copy, Paste, and Clear commands located on the Edit menu to affect an entire CourseBuilder Interaction.
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Edit an entire CourseBuilder Interaction:

Select the CourseBuilder Interaction icon in the document and, 

• Choose Edit > Cut to cut a CourseBuilder Interaction from a document.

• Choose Edit > Copy to copy a CourseBuilder Interaction.

• Choose Edit > Paste to paste a CourseBuilder Interaction. If you copy the CourseBuilder Interaction into the same 

document, the name of the new interaction increments by one to avoid duplicating the name of the original 

interaction.

• Choose Edit > Clear to delete a CourseBuilder Interaction from a document as well as to delete any HTML source 

code associated to the interaction.

Customizing feedback

Many of the CourseBuilder Interaction templates have a correct response set by default. The feedback that appears 

when a user responds is also provided by default.

If you set a tries limit or a time limit, the feedback that appears when the limit is reached is also provided by default.

When you customize feedback, you can embed JavaScript variables in the text of the message to personalize the 

feedback for each student. See “JavaScript variables for tracking performance” on page 111.

Change the default feedback for correct, incorrect, or unknown responses:

1 Open the CourseBuilder Interaction dialog box, then click the Action Manager tab.

2 Go to the Correctness segment.

3 Under the "if Correct" condition, select Popup Message; then click Edit.

4 In the Popup Message dialog box, type the text that must appear when a user's response to the CourseBuilder 

Interaction is correct, and click OK.

5 Under the "else if Incorrect" condition, select Popup Message; then click Edit.

6 In the Popup Message dialog box, type the text that must appear when a user's response to the CourseBuilder 

Interaction is incorrect, and click OK.

7 Under the "else if Unknown Response" condition, select Popup Message; then click Edit.

8 In the Popup Message dialog box, type the text that must appear when a user's response to the CourseBuilder 

Interaction is not known, and click OK.

Change the default feedback for a time or tries limit:

1 Open the CourseBuilder Interaction dialog box, then click the Action Manager tab.

2 In the Check Time or Check Tries segment, select Popup Message, and click Edit.

3 In the Popup Message dialog box, type the text that must appear if a user reaches the tries limit, and click OK.
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Displaying feedback in a frame, layer, status bar, or text 
field

The default feedback provided by the templates appears in a pop-up message. You can also display feedback in a frame, 

a DIV, a status bar, or a text field.

Displaying feedback in a frame

For information about creating frames, see the "Using Frames" chapter in the Dreamweaver documentation.

Display text in a frame instead of a pop-up message:

1 Create a frame to use for feedback.

2 In the Frame Property inspector, in the FrameName field, type a name for the frame.

3 Select the CourseBuilder Interaction for which you create feedback.

4 In the CourseBuilder Interaction dialog box, click the Action Manager tab.

5 In the Action Manager list, select the action you want the feedback to follow.

6 In the Action pop-up menu, choose Set Text of Frame, then click Add.

7 In the Set Text of Frame dialog box, in the Frame pop-up menu, choose the frame in which you want the text 

displayed.

8 In the New HTML field, type the feedback message that must be displayed.

9 Click OK to close the dialog box.

Displaying feedback in a DIV

For information about creating DIVs, see the "Using DIVs" chapter in the Dreamweaver documentation.

Display text in a DIV instead of a pop-up message:

1 Create a frame to use for feedback.

2 Position the DIV in the Document window.

3 In the DIV Property inspector, in the DIV ID field, type a name for the frame.

4 Select the CourseBuilder Interaction for which you create feedback.

5 In the CourseBuilder Interaction dialog box, click the Action Manager tab.

6 In the Action Manager list, select the action you want the feedback to follow.

7 In the Action pop-up menu, choose Set Text of Container, then click Add.

8 In the Set Text of Container dialog box, in the Container pop-up menu, choose the frame in which the text must 

display.

9 In the New HTML field, type the feedback message that must be displayed.

10  Click OK to close the dialog box.

Displaying feedback in a status bar

1 Select the CourseBuilder Interaction for which you create feedback.

2 In the CourseBuilder Interaction dialog box, click the Action Manager tab.
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3 In the Action Manager list, select the action you want the feedback to follow.

4 In the Action pop-up menu, choose Set Text of Status Bar, then click Add.

5 In the Set Text of Status Bar dialog box, in the Message field, type the text of the feedback message you want to 

display.

6 Click OK to close the dialog box.

Displaying feedback in a text field

For information about creating forms, see the "Using Forms" chapter in the Dreamweaver documentation.

1 Create a text field to use for feedback.

2 In the Text Field Property inspector, in the TextField field, type a name for the text field.

3 Select the CourseBuilder Interaction for which you create feedback.

4 In the CourseBuilder Interaction dialog box, click the Action Manager tab.

5 In the Action Manager list, select the action you want the feedback to follow.

6 In the Action pop-up menu, choose Set Text of Text Field, then click Add.

7 In the Set Text of Text Field dialog box, in the Text Field pop-up menu, choose the text field in which the feedback 

will be displayed.

8 In the New Text field, type the feedback message that must display.

9 Click OK to close the dialog box.

Limiting the number of tries

1 Open the CourseBuilder Interaction dialog box, then click the General tab.

2 In the Tries Are field, type the number of tries you want to allow.

The CourseBuilder Interaction template provides default feedback if a user reaches the number of tries you have set as 

the limit.

Edit the preferences file to set a new default tries limit for all the templates.

Putting a time limit on an interaction

1 Open the CourseBuilder Interaction dialog box, then click the General tab.

2 In the Time Is field, type the number of seconds you want to give users to respond to the interaction.

The CourseBuilder Interaction template provides default feedback if time runs out before a user responds.

Edit the preferences file to set a new default time limit for all the templates.
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Setting when a CourseBuilder Interaction is judged

Judge has two meanings in CourseBuilder for Dreamweaver. One is the more obvious instructional meaning: 

evaluating whether a user's response is right or wrong—or not judged at all. The other meaning is programmatic: 

judging an interaction means executing the code in the Action Manager. Judging an interaction may involve 

evaluating a student's response as right or wrong, but it does not have to. On the other hand, evaluating a student's 

response can happen only when the CourseBuilder Interaction executes the code in the Action Manager.

The Judge Interaction option on the General tab determines when the CourseBuilder Interaction executes the code in 

the Action Manager. The CourseBuilder Interaction may incidentally evaluate whether the user's response is right or 

wrong, but only if there is code in the Action Manager that causes something to happen based on whether the response 

was marked as right or wrong.

You can choose one of three types of events to trigger the execution of the code in the Action Manager:

A user action characteristic of the CourseBuilder Interaction: For example, a user selects an answer in a multiple-

choice question, or a user drags an element to a target. Such actions produce immediate results: as soon as a user selects 

an answer in a multiple-choice question, the CourseBuilder Interaction immediately executes the code in the Action 

Manager—perhaps to provide feedback, perhaps (for example, in an online survey) merely to record the answer and 

to go to the next question.

A user clicking a Submit button: In an all-that-apply question or in a drag-and-drop matching exercise with several 

matching pairs, the CourseBuilder Interaction has no way of knowing when the user has finished responding except 

through a mechanism that is not part of the interaction. Clicking Submit instructs the CourseBuilder Interaction to 

start executing the code in the Action Manager.

An event entirely outside the CourseBuilder Interaction: Imagine a series of pages with a CourseBuilder Interaction 

on each page and a Next button that takes the user to the next page. Attached to the BODY tag of the page is a behavior 

consisting of an onUnload event and a Judge action. When a user clicks the Next button, it triggers the onUnload 

event, which in turn triggers the Judge action, which executes the code in the Action Manager.

Setting a tries or time limit for an interaction is another way of choosing an event that can trigger the execution of the 

Action Manager.

Set when a CourseBuilder Interaction is judged:

1 Open the CourseBuilder Interaction dialog box, then click the General tab.

2 Choose the appropriate setting for the Judge Interaction option:

• When the user clicks a button labeled Submit

• When the user performs an action characteristic of the interaction

• On a specific event

Changing the name of the Submit button

1 Open the CourseBuilder Interaction dialog box, then click the General tab.

2 Find the Judge Interaction section.

The first option is "when the user clicks a button labeled Submit."

3 Replace Submit with the text that must appear on the button.

Edit the preferences file to set a new default label for the Submit button in all of the templates. 
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Resetting a CourseBuilder Interaction

Resetting clears any input a user has made during an interaction and returns all the properties of the interaction to 

their initial settings. Clicking a Reset button does not, however, deselect any selected radio buttons in a multiple-choice 

interaction. Some CourseBuilder Interactions, such as all-that-apply questions, are set up by default to allow users to 

reset them.

Edit the preferences file to change the label on the Reset button in all of the templates. 

To allow users to reset a CourseBuilder Interaction:

1 Open the CourseBuilder Interaction dialog box, then click the General tab.

2 Select the Reset option.

To prevent users from resetting a CourseBuilder Interaction, deselect the Reset option.

Inserting a CourseBuilder Interaction into a layer

The "Insert this Interaction in a DIV" option on the General tab places a CourseBuilder Interaction in its own DIV. 

Inserting a CourseBuilder Interaction into a DIV allows absolute placement of the CourseBuilder Interaction on the page.

Inserting a CourseBuilder Interaction into its own DIV also facilitates the use of various actions, such as Show-Hide 

Elements.

Multiple-choice, button, text entry, and timer CourseBuilder 

Interactions are placed in a DIV in their entirety.

Drag-and-drop, explore, and slider CourseBuilder 

Interactions already contain elements in DIVs. Only the text part of the CourseBuilder Interaction and the Submit 

and Reset buttons are placed in a DIV.

To insert a CourseBuilder Interaction into a DIV, do either of the following:

• Open the CourseBuilder Interaction dialog box, click the General tab, then select "Insert this Interaction in a DIV."

• Select the CourseBuilder Interaction icon in the document, then select "Insert this Interaction in a DIV" in the 

Property inspector.

Setting preferences

Edit Preferences.txt to set, among other things:

• The default names of the script and image folders

• The default tries and time limits used in all of the templates

• The default labels on Submit and Reset buttons

For information about all of the defaults you can set, see Preferences.txt. This file is located in Dreamweaver 

CS5\CourseBuilder\Config.
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Managing CourseBuilder Interaction templates

After you customize a CourseBuilder Interaction, you can save it as a template. Your new templates will be available 

for you to select in the CourseBuilder Interaction Gallery. Adding templates to the CourseBuilder Interaction Gallery 

lets you easily generate multiple instances of a custom CourseBuilder Interaction without redefining an object from 

scratch each time.

You can add your CourseBuilder Interaction template to an existing category of CourseBuilder Interactions or create 

new categories for organizing templates.

Adding a CourseBuilder Interaction template to the 
Gallery

After you customize a CourseBuilder Interaction, use the Add Interaction To Gallery command to save the interaction 

as a template so you can use it again. Add the CourseBuilder Interaction template to an existing category of 

CourseBuilder Interactions, or create a category.

Save a CourseBuilder Interaction as a template:

1 In the Document window, select the CourseBuilder Interaction icon.

2 Choose Modify > CourseBuilder > Add Interaction To Gallery.

3 In the Add Interaction To Gallery dialog box, select or create a Gallery Category.

Existing saves the template in the category selected from the pop-up menu to the right. Select the appropriate 

category.

New saves the template in a new category. Use the field to give the category a name.

4 Name the template.

Existing replaces an existing template. Template files that are locked or that are set to "read only" cannot be 

replaced.

New creates a template with a new name.

5 Click Select Icon to select an icon for the template.

The icon represents the template in the Gallery.

6 Click OK.

Creating a custom icon for a template

Create custom icons to make customized CourseBuilder Interaction templates easier to identify in the Gallery.

Use a graphics tool to develop a custom GIF image. The recommended size of the image is 80 x 80 pixels. The image 

can be of any size, but CourseBuilder for Adobe Dreamweaver stretches or shrinks it to 80 x 80 pixels.

Place the image in Dreamweaver CS5\CourseBuilder\SupportFiles\Images.
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Working with Gallery files

All of the CourseBuilder Interaction templates are located in category folders in Dreamweaver\CourseBuilder\Gallery.

Each CourseBuilder Interaction category corresponds to an individual folder preceded by a number. The number 

determines the sequence in which the categories are displayed in the Category list in the CourseBuilder Interaction 

dialog box. For example, the Multiple Choice category (folder name 010_MultipleChoice) precedes the Drag and Drop 

category (folder name 020_Drag and Drop).

In each category folder are template files. The templates are also ordered numerically. Each template is composed of 

two files with the same file name: a template file with the extension AGT and the template icon with the extension GIF.

Arrange the categories and templates in the CourseBuilder Interaction Gallery to reflect the way you use 

CourseBuilder for Dreamweaver.

Change category order in the Category list:

1 In the Gallery folder, locate the folder for the category you want to change.

2 Select the category folder, and change its number to reposition the interaction type in the Category list.

Replace the number with a lower number to move the icon toward the top of the list or with a higher number to 

move it toward the bottom of the list.

Change placement of a template in the Gallery:

1 Locate the appropriate CourseBuilder Interaction category folder in the Gallery folder.

2 Select the template's GIF file, and change its number to reposition the template icon in the Gallery.

Replace the number with a lower number to move the icon forward in the display or with a higher number to move 

the icon back in the display.

3 Select the template's AGT file.

4 Replace the number with the same number you gave the template's GIF file.

Delete a template:

1 Locate the appropriate CourseBuilder Interaction category folder in the Gallery folder.

2 Select the template's GIF file, and delete it.

3 Select the template's AGT file, and delete it.
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Chapter 12: CourseBuilder Interaction 
Controls

Button CourseBuilder interactions

Use button CourseBuilder Interactions as web page navigation controls or as part of a complex interaction, such as a 

simulation of airplane cockpit controls. You can also use the multiple-choice templates to create certain types of button 

interactions. For details, see “The multiple-choice templates” on page 28.

The button templates are easy to use, but unlike most of the other templates, the CourseBuilder Interaction they place 

on a page—simple push buttons or toggle switches—do not do anything particularly useful by themselves. To use a 

button effectively, set it up as a component of some larger interaction. Doing so requires an understanding of how an 

Action Manager works, the actions that are available in CourseBuilder Interactions, and what each action does. 

Several different button images are available for you to choose from. You can also use button images you have created.

The button templates

Choose either of two button templates. The template icons represent the function of each button, not its appearance.

Toggle switch: Button_Toggle

Remains in a given position once set. Switch it on, it remains on; switch it off, it remains off. The CourseBuilder 

Interaction is set up to judge a user's response as soon as the user clicks the button. The CourseBuilder Interaction 

displays feedback when the user clicks the button, displaying a pop-up message that says whether the button is 

currently selected or deselected.

Push button: Button_Push 

Returns to its deselected state right after it is clicked. The CourseBuilder Interaction is set up to judge a user's response 

as soon as the user clicks the button. The CourseBuilder Interaction displays feedback when the user clicks the button, 

displaying a pop-up message that says simply that the button has been pushed. 

Creating a button

What a button does is determined by the actions you set up in the button CourseBuilder Interaction's Action Manager. 

In the templates, selecting either state of a toggle switch or clicking a push button produces the same results: a Popup 

Message action displays a message telling the user either which state a toggle switch is in or simply that a button has 

been pushed. To change what a button does, replace the Popup Message action with a different action.

You might replace the Popup Message action with an action that is equally simple, such as Go To URL. If the button 

is part of a complex interaction—such as a simulation of airplane cockpit controls—you might replace the Popup 

Message action with a Judge Interaction action, which triggers the evaluation of an entire Action Manager. You might 

replace the Popup Message action with several actions or even with conditions that trigger different actions, depending 

on the current state of other parts of the interaction.

To create a button:

1 Open the CourseBuilder Interaction dialog box.

2 In the Gallery tab, select Button from the Category list.
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3 Select a button template. The template icons represent the function of each button, not its appearance.

4 Click the General tab.

A thumbnail of the button appears in the upper right corner of the General tab.

5 Click OK.

The Button CourseBuilder interaction options

General tab

Tracking tab

This tab appears only if you select the Knowledge Track option on the General tab. The settings on the Tracking tab 

specify interaction properties that may be recorded by a CMI or database server application. Use JavaScript variables 

to check the current value of these properties.

Field Description

Interaction Name Unique name of the interaction.

Appearance Name of the image file used for the button graphic.

Highlight on mouse 

over

Highlights the button when the mouse is over it. 

Initial state Describes the default state of the button- its state before the user takes any action. 

• Deselected: Off (toggle switch) or up (push button) state.

• Selected: On (toggle switch) or down (push button) state.

• Enabled: Responds if clicked.

• Disabled: Cannot be clicked. 

Judge Interaction Specifies when the interaction begins to evaluate the conditions in the Action Manager. 

Correct When Defines the interaction as correct (or not judged), depending on whether the button is up or down. 

Score Assigns a score to clicking the button correctly. The score is passed to a management system for tracking, or 

called and displayed through custom JavaScript. 

Type Determines whether the interaction contains a push button or a toggle switch. 

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you 

have one installed. When you check this option, a Tracking tab appears where you enter more information 

about scoring for the CourseBuilder Interaction. 

Time Is Determines the amount of time in seconds that the user has to complete the interaction.

Time Are Determines the number of tries a user has to complete the interaction.

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder 

Interaction on the page. 
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Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions if a user:

• Selects or deselects a toggle switch

• Clicks a push button

• Reaches a time limit that you've set on the General tab

• Reaches the number of tries that you've set on the General tab

Adding custom button graphics

A button object must contain at least two GIF images: the default button and a thumbnail. The thumbnail appears as 

a graphic preview in the CourseBuilder interaction dialog box. The thumbnail is displayed in a fixed area of 100 by 100 

pixels and is resized to fill this area if the thumbnail is a different size.

You can include other graphics to represent the button in its various states, giving the user a visual indication of what 

state the button is in and what action results from clicking it. If you do not include a highlighted image, you cannot 

select the Highlight on mouse over option.

Do not confuse the button graphics with the icons that represent the button templates in the Gallery. See “Managing 

CourseBuilder Interaction templates” on page 69 for information on adding images associated with object templates.

To create a custom button:

1 Use a graphics tool to create a GIF image for the default button and any additional graphics to represent the button 

in its various states.

2 Name the GIFs representing various button states as follows (appearancename is the label used in the Appearance 

pop-up menu):

appearancename.gif The default button graphic, showing the button as enabled and deselected.

appearancename_tnail.gif The 100 by 100 pixel thumbnail button graphic, displayed as a preview on the 

General tab.

appearancename_hlt.gif The button graphic representing a highlighted button (how the button appears when 

the pointer is over it).

appearancename_sel.gif The button graphic representing a selected button (how the button appears when 

"pushed down").

appearancename_dis.gif The button graphic representing a disabled button.

appearancename_sel_hlt.gif The button graphic representing a toggle button when it's both selected ("pushed 

down") and highlighted (when the pointer is over it).

appearancename_sel_dis.gif The button graphic representing a button when it's both selected ("pushed 

down") and disabled.

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight Optional setting to indicate the relative importance of the interaction. CMI systems may use the value of this 

property for scoring and grading students.



74USING ADOBE ELEARNING SUITE COURSEBUILDER EXTENSION

CourseBuilder Interaction Controls

Last updated 4/1/2011

3 Save all of the button object GIFs in the following directory:

\Dreamweaver\CourseBuilder\SupportFiles\Images\Buttons\

Before you use custom graphics in a CourseBuilder Interactions document, use the Copy Support Files command to 

copy the custom graphics to the folder where the CourseBuilder Interactions document is located. For details, see 

“Copying support files” on page 24.

Timer CourseBuilder interaction

A timer shows time passing as users complete an interaction.

You can use the timer to keep users focused, motivate them (for example, by adding or removing scoring points as 

users progress through an interaction), or monitor their progress and notify them of whether they have achieved 

certain tasks within a time limit. Often, time is integral to whether a user has mastered a subject. For example, a 

paramedic must be able to identify the correct procedures for triage without trying to recall them from class or a 

textbook.

The timer templates

Choose from two Timer CourseBuilder Interaction templates. The template icons represent the function of each timer, 

not its appearance. 

Timer: Timer_Forward1Trig

Gives users feedback after 30 seconds. Both the trigger when the timer runs out of time and the period leading up to it 

are unjudged. The CourseBuilder Interaction executes the Action Manager only if the timer reaches the trigger. If the 

timer reaches the trigger, the Action Manager displays a message in a pop-up window. The CourseBuilder Interaction 

has a Reset button that lets the user restart the timer either while it runs or after it runs out of time.

Timer with warning: Timer_Forward2Trigs

Gives users feedback after 15 seconds and 30 seconds. The CourseBuilder Interaction displays a horizontal gradient 

bar as the timer ticks off the seconds. The period leading up to the warning trigger at 15 seconds, the warning trigger 

itself, and the final trigger at 30 seconds are all unjudged. The CourseBuilder interaction executes the Action Manager 

only when the timer reaches a trigger. When the timer reaches a trigger, the Action Manager displays a message in a 

pop-up window. The CourseBuilder Interaction has a Reset button that lets the user restart the timer either while it 

runs or after it runs out of time.

The Timer CourseBuilder Interaction options

General tab

Field Description

Interaction Name Unique name of the interaction.

Appearance Selects the look of the Timer CourseBuilder Interaction. 

Duration The total time on the timer. You can modify the duration.

Reverse image order Reverses the order in which the series of timer images are displayed (for example, the timer may appear to 

count down). 
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Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. The settings on 

the Tracking tab specify interaction properties that may be recorded by a CMI or database server application. Use 

JavaScript variables to check the current value of these properties.

Triggers tab

Triggers tab defines the trigger values on a timer and any properties that apply to them. 

Judge Interaction Specifies when the CourseBuilder Interaction begins to evaluate the conditions in the Action Manager. 

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as 

correct within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as 

correct if the response corresponds to any of the correct answers.

•  All Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as 

correct only if the response corresponds to all of the correct answers. 

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you 

have one installed. When you check this option, a Tracking tab appears where you enter more information 

about scoring for the CourseBuilder Interaction. 

Time Is Determines the amount of time in seconds that the user has to complete the interaction. 

Tries Are Determines the number of tries a user has to complete the interaction.

Reset Adds an HTML form button to reset. 

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder 

Interaction on the page. 

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight Optional setting to indicate the relative importance of the interaction. CMI systems may use the value of 

this property for scoring and grading students.

Field Description

Triggers Lists all of the triggers in the CourseBuilder Interaction.

Name  Name of the selected trigger. You can modify the trigger. The templates assign default names (Trigger1, 

Trigger2, and so on) to each trigger. Giving a trigger a more descriptive name (such as "Warning") makes it 

easier to work with. The name you give a trigger appears only in the CourseBuilder Interaction dialog box. The 

name is case sensitive and cannot be reused for another trigger. All of the characters must be alphanumeric, 

and the name cannot contain spaces.

Add/Deletes Use to add/delete entries in the list of triggers.

Name Labels the current trigger. The name is case sensitive and cannot be reused for another trigger. All of the 

characters must be alphanumeric, and the name cannot contain spaces.

Interaction Is Defines a user's response, if it occurs before the timer reaches the first trigger, as correct, incorrect, or not 

judged. This option applies to the timer CourseBuilder Interaction as a whole. 

Field Description
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Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

interaction behaves if the timer reaches a trigger you have set on the Triggers tab.

Creating a timer/timer with a warning

1 Open the CourseBuilder Interaction dialog box.

2 Select Timer from the Category list.

3 Select the icon for timer template/timer with a warning template. The template icon represents the function of the 

timer, not its appearance.

4 Click the General tab. Use the Duration option to set the amount of time on the timer.

5 Do one of the following:

• (For timer) Click the Triggers tab. Change the Trigger Once After setting to match the Duration setting.

• (For timer with warning) Click the Triggers tab. In the Triggers list, select Trigger1 and set Trigger Once After 

to the time you want the warning to appear and In the Triggers list, select Trigger2 and set Trigger Once After 

to match the Duration setting.

6 Click OK.

Setting a trigger

1 In the Triggers tab, go to the Triggers list and select the name of the trigger you want to set.

2 Set Trigger Once After to the time you want the trigger to occur.

3 To judge a user's response as correct or incorrect when the timer reaches the trigger, set the Trigger Is option.

4 To change the feedback that appears when the timer reaches the trigger, use the Action Manager.

Adding custom timer graphics

Each timer object is made up of a series of GIF images. What the user sees as a single timer is actually a series of 

graphics, each representing a different point in time, displayed one after the other to give the illusion of elapsing time.

In addition to the timer images, a timer object includes a thumbnail. The thumbnail appears as a graphic preview in 

the CourseBuilder Interaction dialog box. The thumbnail is displayed in a fixed area of 100 by 100 pixels and is resized 

to fill this area if the thumbnail is a different size.

Do not confuse the timer graphics with the GIFs that represent the CourseBuilder Interaction template files in the 

Gallery. See “Managing CourseBuilder Interaction templates” on page 69 for information on adding images associated 

with object templates.

Trigger One After 

__ seconds

Sets the point at which the timer is triggered.

Trigger Is Defines the current trigger, when reached, as correct, incorrect, or not judged. How the trigger is judged 

determines the type of feedback generated when the timer reaches the trigger. 

Score Assigns a score to the current trigger. The score is passed to a management system for tracking or called and 

displayed through custom JavaScript.

Field Description
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To create a custom timer:

1 Use a graphics tool to create the GIF images that represent the timer.

For example, if your timer counts for 30 seconds, the object can include 30 GIFs (each representing one elapsed 

second), 15 GIFs (each representing two elapsed seconds), or any other number of GIFs representing equal 

divisions of the time interval.

2 Name the GIF images in numerical order.

The GIF images replace each other in order. For example, gradient_01.gif is swapped for gradient_02.gif, which is 

then swapped for gradient_03.gif, and so on, until the time limit is reached and all GIFs have been displayed.

Use the following file name format:

appearancename_##.gif

appearancename is the label used on the Appearance pop-up menu.

## designates the position the graphic occupies in the swap order.

For example, the file name gradient_01.gif would be the first graphic displayed for a timer object listed on the 

Appearance pop-up menu as gradient.

3 Save the timer GIFs in the directory:

\Dreamweaver\CourseBuilder\SupportFiles\Images\Timers\

4 Create a 100 by 100 pixel GIF for the thumbnail and name it appearancename_tnail.gif.

appearancename is the same root name used for the thumbnail's corresponding timer graphics.

5 Save the thumbnail graphic in the same directory as the other timer object graphics:

\Dreamweaver\CourseBuilder\SupportFiles\Images\Timers\

Before you use custom graphics in a CourseBuilder interactions document, use the Copy Support Files command to 

copy the custom graphics to the folder where the CourseBuilder Interactions document is located. See “Copying 

support files” on page 24.

Slider CourseBuilder interaction

A slider gives users a way to select a choice or range of choices on a linear scale of values.

You can use a slider to represent a control, such as a dimmer switch in a home or an airplane's flap lever. You can set 

up a slider to select a broad range—for example, a temperature or pH range—or a discrete value—for example, a page, 

topic, chapter, or exercise.

The slider templates

Choose either of two slider templates. The template icons represent the function of each slider, not its appearance.

Range slider: Slider_2Ranges

Has an overall range of 0 to 100, and two active ranges: one from 0 to 49, the other from 50 to 100. Both ranges are not 

judged. The CourseBuilder interaction executes the Action Manager when the user releases the slider thumb. The 

feedback for each of the ranges is different. The CourseBuilder interaction has a Reset button that lets the user reset 

the slider after releasing the slider thumb.
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Point slider: Slider_Correct Range

Has an overall range of 0 to 100, and three active ranges: the first from 0 to 48, the second from 49 to 51, and the third 

from 52 to 100. Only the single-point range (from 49 to 51) is correct; the other two ranges are incorrect. The 

CourseBuilder interaction executes the Action Manager when the user releases the slider thumb. The feedback for each 

of the ranges is different. The CourseBuilder interaction has a Reset button that lets the user reset the slider after 

releasing the slider thumb.

The Slider CourseBuilder Interaction options

General tab

Action Manager tab

The Action Manager tab contains code segments set up as if...then conditions that define how a CourseBuilder 

Interaction behaves under specific conditions if a user:

• Reaches a time limit that you set on the General tab

• Drags the slider thumb to an active range on the slider

• Reaches the number of tries that you set on the General tab

Field Description

Interaction Name Unique name of the interaction.

Judge Interaction Starts the evaluation as soon as the user stops dragging the thumb of the slider. 

Knowledge Track Passes information about user input to an external computer-managed instruction (CMI) application, if you 

have one installed. When you check this option, a Tracking tab appears where you enter more information 

about scoring for the CourseBuilder Interaction.

Correct When Defines what qualifies as a correct response to the entire interaction if more than one response is marked as 

correct within the interaction.

• Any Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as 

correct if the response corresponds to any of the correct answers.

• All Correct and None Incorrect: Causes CourseBuilder to judge a user's response to the interaction as correct 

only if the response corresponds to all of the correct answers.

Time Is Determines the amount of time in seconds that the user has to complete the interaction. 

Tries Are Determines the number of tries a user has to complete the interaction.

Reset Adds an HTML form button to the CourseBuilder Interaction to clear user input during the interaction. 

DIV Places a CourseBuilder Interaction in its own DIV, allowing for absolute placement of the CourseBuilder 

Interaction on the page.

Range Defines the beginning and end values of the slider. Enter decimal numbers to display decimal values on the 

slider (for example, 1.0 to 2.5). The range can be low to high (1 to 10) or high to low (10 to 1). Enter both 

negative and positive numbers (-10 to 10). Positive numbers can be ten digits long; negative numbers, nine 

digits. 

Appearance Selects the look of the slider. Each look is designed to operate either horizontally or vertically, indicated by hor 

or vert in the file name.

Initial value Sets the position of the slider's thumb, where it remains until the user moves it.
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Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab. The settings on 

the Tracking tab specify interaction properties that may be recorded by a CMI or database server application. Use 

JavaScript variables to check the current value of these properties.

Ranges tab

The Ranges tab defines the slider's ranges and any properties that apply to them.

Creating a range slider/point slider

To create a range slider:

1 Open the CourseBuilder Interaction dialog box.

2 Select Slider from the Category list.

3 Select the range slider/point slider template icon. The template icon represents the function of the slider, not its 

appearance.

4 Click the General tab. Set the slider's start and end values in the Range fields.

5 Set the initial position of the slider thumb in the Initial field.

A thumbnail of the timer appears in the upper right corner of the General tab. 

Field Description

Interaction ID Identifies the interaction in the CMI system.

Objective ID Identifies a specific objective that the interaction is related to in the CMI system.

Weight Optional setting to indicate the relative importance of the interaction. CMI systems may use the value of this 

property for scoring and grading students.

Field Description

Ranges Ranges contains an entry for each range in the CourseBuilder Interaction, along with information about how the 

range has to be judged.

Add/Delete Creates an entry in the list of ranges or delete removes the selected entry from the list of ranges.

Name Labels the current range. The name is case sensitive and cannot be reused for another range, once defined. All 

characters must be alphanumeric, and the name cannot contain spaces. You can modify the name.

Range __ to __ 

units 

Sets the values that define a range. The start and end values that you enter are included in the range. 

Range Is Defines the current range, when reached, as correct, incorrect, or not judged. How the range is judged determines 

the type of feedback generated when the user moves the slider thumb within the range you have defined. 

Score Assigns a score to the current range. The score is passed to a management system for tracking or called and 

displayed through custom JavaScript. 

Choice Is Determines whether a range is right or wrong.

Range Defines the limit of current range.
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6 Click the Ranges tab. In the Ranges list, select Range1 and set the start and end values of the range in the Range 

fields. Do the same for Range2. In the case of Point slider, do the same of Range3 (Remember that Range2 is correct; 

Range1 and Range3 are incorrect.

To change the messages that appear when the slider's thumb is in a given range, use the Action Manager. 

7 Click OK.

Setting a slider's start and end values

A slider's start and end values determine the overall range that appears on the slider. The default settings are 0 and 100. 

The slider's thumb, by default, appears at 0.

To set the overall range of a slider:

1 Open the CourseBuilder interaction dialog box, then click the General tab.

2 In the Range fields, type the slider's start and end values.

Enter decimal numbers to display decimal values on the slider (for example, 1.0 to 2.5). The range can be low to 

high (1 to 10) or high to low (10 to 1). Enter both negative and positive numbers (-10 to 10). Positive numbers may 

be ten digits long; negative numbers, nine digits.

To set the initial position of the slider's thumb, type the value that corresponds to the position in the Initial field. The 

value can be no less than nor greater than the values in the Range fields.

Adding custom slider graphics

Each slider contains two GIF images: one each for the thumb and the track. A slider also includes a thumbnail. The 

thumbnail appears as a graphic preview in the CourseBuilder interaction dialog box. The thumbnail is displayed in a 

fixed area of 100 by 100 pixels and is resized to fill this area if the thumbnail is a different size.

Do not confuse the slider graphics with the GIFs that represent the CourseBuilder Interaction template files in the 

Gallery. See“Managing CourseBuilder Interaction templates” on page 69 for information on adding images associated 

with object templates.

To create a custom slider:

1 Create or select the three GIF images for the slider thumb and track.

2 Name the GIFs, using the following file name format:

appearancename_[hor/ver]_[thm/trk].gif

Appearancename is the label used in the Appearance pop-up menu.

Hor or ver indicates that the slider is horizontal or vertical.

Thm (thumb) and trk (track) designate the function of the graphic.

For example, the file name modern_ver_thm.gif is the thumb of a vertical slider whose appearance is modern.

3 Save the GIF images in the following directory:

\Dreamweaver CS5\CourseBuilder\SupportFiles\Images\Sliders\

4 Create a 100 by 100 pixel GIF for the thumbnail and name it:

appearancename_tnail.gif
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Appearancename is the same root name used for the thumbnail's corresponding slider graphics.

5 Save the thumbnail graphic in the same directory as the other slider object graphics:

\Dreamweaver CS5\CourseBuilder\SupportFiles\Images\Sliders\

Before you use custom graphics in a CourseBuilder interactions document, use the Copy Support Files command to 

copy the custom graphics to the folder where the CourseBuilder Interactions document is located. See “Copying 

support files” on page 24.
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Chapter 13: Action Manager

Action Manager CourseBuilder interactions

The Action Manager tab lists all of the conditions and actions that apply to a CourseBuilder Interaction. These 

conditions and actions, organized into segments, define how a CourseBuilder Interaction interacts with the user at 

runtime. Use the Action Manager tab to create new segments, define new conditions, and set the properties of actions 

in the list.

Action Manager pop-up menu

The items in the Action Manager menu are grouped into six categories, divided by dashed lines. You can edit the order 

of the items in the menu and the names of the segments in the ActionMenu.htm file. For example, you can move the 

items you use often to the top of the list.

Any items not defined in ActionMenu.htm appear in the final category.

To rearrange the Action Manager pop-up menu items:

1 Open the file ActionMenu.htm located in Dreamweaver CS5\CourseBuilder\Config.

2 Edit the items to reflect the naming and order you prefer.

3 Save your changes to the file.

Action Manager segments

Each template has a set of segments in the Action Manager that determine what happens when the CourseBuilder 

Interaction evaluates a user's response. The point at which the CourseBuilder Interaction executes the Action Manager 

is determined by the Judge Interaction setting on the General tab. Judge, in fact, does not necessarily mean evaluating 

the student's performance; its literal meaning is simply, executing the code in the Action Manager.

Category Contains Consists of

1 Built-in Action Manager 

items

Consists of Segment, Condition, Else, and Stop. This is the one section in the list that you 

cannot change and is not part of the ActionMenu.htm file. 

2 CourseBuilder actions Consists of Judge Interaction, Reset Interaction, and Set Interaction Properties.

3 Behaviors that ship with 

Adobe Dreamweaver

Call JavaScript, Change Property, Check Browser, Check plug-in, Control Shockwave or 

Flash, Control Sound, Drag AP Element, Display Status Message, Go To URL, Open Browser 

Window, Popup Message, Preload, Images, Show-Hide Elements, Swap Image, Swap 

Image Restore, and Validate Form

4 Feedback actions Set Text of Frame, Set Text of Container, Set Text of Status Bar, and Set Text of Text Field

5 Timeline actions Go To Timeline Frame, Play Timeline, and Stop Timeline

6 Knowledge Track actions Send Core Data, Send GetParam, Send Interaction Info, Send Lesson Status, Send Lesson 

Time, Send Objective Info, and Send Score
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Check Time segment

The Check Time segment is a standard segment that's part of all the templates. It contains one condition—"if Time At 

Limit"—that compares the Time At Limit property with the Time Is setting on the General tab. If the "if Time At Limit" 

condition is true, it triggers a Popup Message action (which lets the user know time has run out) and a Set Properties 

action (which disables the interaction).

By default, the time setting in the General tab is set to Unlimited. To set a time limit, see “Putting a time limit on an 

interaction” on page 66.

To change the default feedback displayed by the Popup Message action, see “Customizing feedback” on page 64. See 

also “Displaying feedback in a frame, layer, status bar, or text field” on page 65.

Correctness segment

The Correctness segment is a standard segment that is part of almost all the templates. It checks three conditions for 

the interaction. First, the "if Correct" condition tests to see if the response by the user is correct, by checking the Correct 

State property to see if it is correct. If that condition is not true, the second condition, "else if Incorrect," checks to see 

if the Correct State property is "Incorrect". The third condition, "else if Unknown Response," tests to see if the Known 

Response property is "False". Simply stated, the conditions ask the questions: Did the user answer correctly? Did the 

user answer incorrectly? Did the user respond at all? In each case, a Popup Message action displays a message that tells 

users whether their response was correct, incorrect, or unknown.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

Check Tries segment

The Check Tries segment is a standard segment that is part of all the templates. It compares the Tries At Limit property 

with the Tries Are setting on the General tab to see if they are equal. If the "if Tries At Limit" condition is true, it triggers 

a Popup Message action (which lets the user know there are no tries left) and a Set Properties action (which disables 

the interaction).

By default, the tries setting in the General tab is set to Unlimited. To set a time limit, see “Limiting the number of tries” 

on page 66.

To change the default feedback displayed by the Popup Message action, see “Customizing feedback” on page 64. See 

also “Displaying feedback in a frame, layer, status bar, or text field” on page 65.

Multiple-choice segments

The Action Managers in the true/false, multiple-choice, graphic multiple-choice, and all-that-apply templates all use 

the three standard segments: 

• “Check Time segment” on page 83

• “Correctness segment” on page 83

• “Check Tries segment” on page 83

For information about the templates, see “The multiple-choice templates” on page 28.
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One-to-one matching segments

The Action Manager in the drag-and-drop one-to-one matching template uses the three standard segments:

• “Check Time segment” on page 83

• “Correctness segment” on page 83

• “Check Tries segment” on page 83

For information about the template, see “The drag-and-drop templates” on page 34.

One-to-one matching (either way) segments

The Action Manager in the drag-and-drop one-to-one matching (either way) template uses two of the three standard 

segments:

• “Check Time segment” on page 83

• “Check Tries segment” on page 83

The Correctness segment is slightly different from the standard Correctness segment. It checks three conditions for 

the interaction. First, the "if Unknown Response" tests to see if the Known Response property is false. If that condition 

is not true (that is, if the response is known), the second condition, "else if Total Correct equals 3," checks to see if the 

Total Correct property for the interaction is equal to 3, the number of possible correct matches. If the condition is true, 

a Popup Message action displays a message letting users know how many correct items they selected. If, however, the 

condition is false, the third condition, "else if incorrect," tests to see if the Total Correct property does not equal 3. If 

that condition is true—that is, if the user did not get all three answers correct—it triggers a Popup Message action that 

uses embedded JavaScript variables to tell the user how many choices out of the total possible were correct.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the template, see “The drag-and-drop templates” on page 34.

One-to-many matching segments

The Action Managers in both drag-and-drop one-to-many matching templates use the three standard segments:

• “Check Time segment” on page 83

• “Correctness segment” on page 83

• “Check Tries segment” on page 83

For information about the templates, see “The drag-and-drop templates” on page 34.

"Build your own" template segments

The Action Manager in the "Build your own" template uses the three standard segments:

• “Check Time segment” on page 83

• “Correctness segment” on page 83

• “Check Tries segment” on page 83

It also includes two special feedback segments:
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In the "DragTarget1 to DragTarget2 Feedback" segment, if the condition "if DragTarget1 to DragTarget2 Selected" is 

true—that is, if a user has dropped DragTarget1 on DragTarget2—it triggers a Popup Message action that displays a 

message stating simply that the user has hit DragTarget 2.

The "DragTarget2 to DragTarget1 Feedback" segment provides the same type of feedback. If the condition "if 

DragTarget2 to DragTarget1 Selected" is true, it triggers a Popup Message action that displays a message stating simply 

that the user has hit DragTarget1.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the template, see “The drag-and-drop templates” on page 34.

Two-step procedure segments

The Action Manager in both two-step procedure templates uses two of the three standard segments:

• “Check Time segment” on page 83

• “Check Tries segment” on page 83

The Two-Step Matching segment is set up to track state transitions, which means that once a condition in the segment 

is true, the CourseBuilder Interaction skips the condition the next time it evaluates the statements in the Action 

Manager. On the other hand, if a condition is false, the CourseBuilder Interaction returns directly to it the next time 

while evaluating the segment.

In the Two-Step Matching segment, the first condition, "if Step1 - Drag1 to Target1 Selected," checks to see if the user 

dropped the drag element on the first target by checking that the Selected property for the drag element and the first 

target element pair is true. If so, the condition triggers a Popup Message action that displays a message stating that the 

user completed the first step.

If the first condition is true, there is another condition nested within the first, "if Step2 - Drag1 to Target2 Selected," 

that the Action Manager tests. The condition checks to see if the user dropped the drag element on the second target 

by checking that the Selected property for the drag element and the second target element pair is true. If so, the 

condition triggers a Popup Message action that displays a message stating that the user successfully completed the 

interaction.

If the user missed the first step—for instance, the user drops the drag element on the second target as the first step—

the "else if Step1 Missed" condition is true. That condition triggers a Popup Message action that displays a message 

stating that the user must match the first target before the second. It then triggers a Reset action that resets the state 

transition of the previous segment so the user can try again. The "else if Step1 Missed" condition is true only if the user 

has not already dropped the drag element on the first target. Once the user drops the drag element on the first target, 

the state transition takes effect. When the user drops the drag element on the second target, the CourseBuilder 

Interaction executes the Action Manager a second time, and goes directly to the second condition, "if Step2 - Drag1 to 

Target2 Selected," when it evaluates the Two-Step Matching segment.

The Drag1 to Target3 Feedback segment, which is part of the two-step procedure with a distractor segment, contains 

one condition, "if Drag1 to Target3 Selected," which checks to see if the user dropped the drag element on Target3. If 

the condition is true, it triggers a Popup Message action that displays a message indicating that the user took an 

incorrect step.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the templates, see “The drag-and-drop templates” on page 34.
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Explore segments

The Action Managers in the explore templates use the three standard segments:

• “Check Time segment” on page 83

• “Correctness segment” on page 83

• “Check Tries segment” on page 83

The Action Managers also contain a series of feedback segments. The Hot Area Feedback segments are all similar: each 

is associated with a different hot area on the page. If the user selects a hot area, the condition "if Hot Area Selected" in 

its associated segment is true. The condition triggers a Popup Message action that displays the number of the area the 

user selected.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the templates, see “The explore templates” on page 50.

Toggle-switch segment

The Action Manager in the toggle-switch template uses two of the three standard segments:

• “Check Time segment” on page 83

• “Check Tries segment” on page 83

It also includes a special feedback segment:

In the Button Selected segment, the first condition, "if Selected," checks to see if the Selected property is true for the 

button. If it is, it triggers a Popup Message action that displays a pop-up message that informs the users that they have 

selected the button. Otherwise, the "else if Deselected" condition checks to see if the Selected property is false. If it is, 

the condition triggers a Popup Message action that displays a pop-up message that informs the users that they have 

deselected the button.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the template, see “The button templates” on page 71.

Pushbutton segment

The Action Manager in the push button template uses two of the three standard segments:

• “Check Time segment” on page 83

• “Check Tries segment” on page 83

It also includes a special feedback segment:

In the Button Feedback segment, the CourseBuilder Interaction executes the Popup Message action any time it 

evaluates the Action Manager. Any time users click the button, a pop-up message appears telling them they've clicked 

the button.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the template, see “The button templates” on page 71.
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Text entry segments

The Action Managers in the text entry templates all use the same three standard segments:

• “Check Time segment” on page 83

• “Correctness segment” on page 83

• “Check Tries segment” on page 83

For information about the templates, see “The text entry templates” on page 55.

Timer segment

The Action Manager in the timer template has a single special feedback segment:

The Trigger1 Feedback segment has a condition, "if Trigger1 Selected," that becomes true when the timer runs out. The 

trigger in the template is set to 30 seconds (see “Setting a trigger” on page 76).

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the template, see “The timer templates” on page 74.

Timer with warning segment

The Action Manager in the timer with a warning template has two special feedback segments:

The Trigger1 Feedback segment (the segment for the warning trigger) has a condition, "if Trigger1 Selected," that 

becomes true when the timer runs out. The trigger in the template is set to 30 seconds (see “Setting a trigger” on 

page 76).

The "if Trigger2 Selected" condition in the second segment, Trigger2 Feedback, becomes true at 30 seconds. Because 

both of the segments are state transitions, the first segment is evaluated until the condition is true, after 15 seconds. 

When that condition is true, the CourseBuilder Interaction skips the first segment when it evaluates the Action 

Manager and goes directly to the second segment.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the template, see “The timer templates” on page 74.

Range slider segment

The Action Manager in range slider templates uses two of the three standard segments:

• “Check Time segment” on page 83

• “Check Tries segment” on page 83

It also includes two special feedback segments:

The "if Range1 Selected" condition in the Range1 Feedback segment is true when the user drags the slider's thumb into 

this range. The "if Range2 Selected" condition in the next segment, Range2 Feedback, is true when the user slides the 

thumb to the other end of the range. The Popup Message action for both conditions displays messages that indicate 

what range the user selected. Because both triggers are not judged, there is no correctness or incorrectness.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.



88USING ADOBE ELEARNING SUITE COURSEBUILDER EXTENSION

Action Manager

Last updated 4/1/2011

For information about the template, see “The slider templates” on page 77.

Point slider segment

The Action Manager in the point slider template uses the three standard segments.

• “Check Time segment” on page 83

• “Correctness segment” on page 83

• “Check Tries segment” on page 83

It also includes two special feedback segments:

The "if Range1 Selected" condition in the Range1 Feedback segment is true when the user drags the slider's thumb into 

its range. The condition triggers a Popup Message action that displays a message saying that the position of the slider 

is too low.

The next segment, Range3 Feedback, contains another condition, "if Range3 Selected," that's true when the user slides 

the thumb to the high end of the range. The condition triggers a Popup Message action that displays a message stating 

that the position is too high. If the user moves the slider to the correct range, the "if Correct" condition in the 

Correctness segment is true, triggering the Popup Message action there.

To change the default feedback displayed by a Popup Message action, see “Customizing feedback” on page 64. See also 

“Displaying feedback in a frame, layer, status bar, or text field” on page 65.

For information about the template, see “The slider templates” on page 77.

Adding a segment

Conditions and actions in a CourseBuilder Interaction are grouped into segments. In addition to providing an 

organizational framework for the conditions and actions in a CourseBuilder Interaction, a segment defines when the 

conditions and actions it contains are evaluated during the execution of CourseBuilder Interaction. Some segments 

are pre-set for a CourseBuilder interaction, based on the CourseBuilder interaction template you are using; you can 

edit these segments or add new ones to the interaction, as needed.

Use the Edit button to change the name of a segment and define when the conditions it contains are evaluated.

To create a segment:

1 Open the CourseBuilder Interaction dialog box and then click the Action Manager tab.

2 Select the segment, condition, or action the new segment will follow.

If the new segment is to appear first in the list, click the first segment in the list and use the up arrow to reposition 

the segment after you have created it.

3 Choose Segment from the pop-up menu and click Add.

The Segment Editor opens.

4 Specify a name, select a Segment Evaluation option, and then click OK.

When the Action Manager judges a CourseBuilder Interaction, it always evaluates segments set to Always evaluate 

from the beginning starting with the first line in the segment.
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The first time the Action Manager encounters a segment set toState transition, it starts evaluating the conditions 

in the segment from the first line in the segment. Upon encountering a condition that is not met, the Action Manager 

skips to the next segment. The next time the Action Manager judges the CourseBuilder Interaction, it skips any 

conditions in the segment that have previously been met and then resumes checking the remaining conditions in that 

segment from that point forward.

Adding a condition

Conditions in a CourseBuilder Interaction define when the object provides feedback during an interaction—when an 

expression is true, the condition is met and any actions within the condition are executed. Most of the CourseBuilder 

Interaction templates contain pre-set conditions. Based on the type of template you use, a variety of preconfigured 

conditions are shown. You can edit, delete, or add conditions as needed.

The Action Manager evaluates conditions in the order they appear, from top to bottom. The order in which you list 

conditions therefore determines the order in which the Action Manager executes the actions at runtime. You can 

always move a condition up or down in the list by selecting it and clicking the Up or Down arrows.

Use the Condition Editor to create custom conditions and edit existing conditions. The content of the Condition 

Editor varies, depending on the nature of the items you are comparing to each other in the condition.

To create a condition:

1 Open the CourseBuilder Interaction dialog box, then click the Action Manager tab. 

2 Select the segment, condition, or action the new condition will follow.

3 Choose Condition from the pop-up menu and click Add.

The Condition Editor opens. The Condition Editor options change, depending on your selections in each field.

4 In the Condition Name field, type a name for the condition.

If you do not specify a name, CourseBuilder for Dreamweaver names it using the expression as the name.

5 Define the expressions that determine if the condition is met.

6 Click OK.

Creating expressions for a condition

An expression is a logical statement that compares a property of an interaction or object with another object, 

interaction, or value. All expressions are formatted as "x comparison y".

Conditions can contain more than one expression. You can string expressions together to make a condition more 

specific—for instance, you can create a single condition that checks whether the user clicked an object and, at the same 

time, makes sure that the user has enough tries remaining when clicking that choice. The Expressions list (at the top 

of the Condition Editor) displays statements that must be true for the condition to be met.

Fields under the Expressions list define pieces of an expression. The fields above the "equals/does not equal" pop-up 

menu define the first half of an expression, while the fields below the pop-up menu define how the first half of the 

expression must be evaluated.

To create an expression:

1 In the Type field, select the type of object being compared.
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2 Do one of the following:

• (For Document Tag as type) Choose the name of the object you want to compare. 

• (For other types) Choose the name of the CourseBuilder Interaction you want to compare.

3 In the Property pop-up menu, select the property that the expression compares for the object.

4 In the "equals/does not equal" pop-up menu, select the type of comparison the expression makes.

The choices available in this pop-up menu change based on your selections in the Type and Property pop-up 

menus.

5 Select the type for the second half of the expression.

As in the first part of the expression, the types you can select from vary with the object.

6 Based on the type you have selected for the second half of the expression, choose the object, interaction, property, 

or value that the expression compares.

To join two or more expressions together, use the And/Or pop-up menu in the lower right corner. Select And if 

both expressions must be true. Select Or if either expression can be true.

7 Click OK.

Type field settings

The Type field settings in the Condition are as follows:

Interaction compares interactive elements of a CourseBuilder Interaction. The first of the two Interaction pop-up 

menus determines the interaction, and the second pop-up menu specifies which element in that interaction (a drag 

item or drop target, a hot area, a choice in a multiple-choice interaction, and so on) the expression evaluates.

Action Manager compares entire segments of a CourseBuilder Interaction. The first of the two interaction pop-up 

menus determines the interaction, and the second pop-up menu specifies which segment in that interaction to 

evaluate.

Document Tag compares a tag in the HTML source code for the page. The first of the two interaction pop-up menus 

determines the type of HTML tag in the condition, and the second pop-up menu specifies the specific HTML tag to 

evaluate.

JavaScript provides a field in which to type your custom JavaScript code or condition.

True/False determines whether the interaction, segment, or HTML tag in the first half of the expression is true (met) 

or false (unmet).

Number compares the property in the first half of the expression with the value you enter in the Number field.

Text compares the property in the first half of the expression with the string you enter in the Text field.

Select compares the property in the first half of the expression with a value of Not Judged, Correct, or Incorrect.

Adding an action

Actions make things happen. When you add an action, define specifically what it acts upon—a Control Sound action, for 

example, must have an associated audio file, and a Go To URL action must have an associated URL to take the user to.
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To add a new action:

1 Open the CourseBuilder dialog box, then click the Action Manager tab.

2 Select the segment, condition, or action the new action will follow.

3 Choose the new action from the pop-up menu and click Add.

4 Define the properties of the action and then click OK.

Working with segment, condition, and action

• Rename: In the Action Manage tab, select the segment/action/condition and then click Rename. In the Name 

Editor, change the name.

• Expand/Collapse a segment or condition: To show the hidden statements in a collapsed segment, condition, or else 

statement, select the statement or condition; then click the Expand button. To hide the statements nested under a 

segment, condition, or else statement, select the statement or condition; then click the Collapse button.

• Promote/Demote a condition: Changing the relationship between conditions is called promoting or demoting a 

condition. Select the condition and then use the left/right arrow buttons to promote/demote.

• Edit: Select the segment/condition/action and then click Edit. 

• Cut, copy, and paste (a segment, condition, or action): Use the Cut, Copy, and Paste buttons at the top of the Action 

Manager tab. If you select a segment, CourseBuilder for Adobe Dreamweaver automatically includes everything 

inside that segment when you cut, copy, or paste. If you select a condition, CourseBuilder for Dreamweaver 

automatically includes everything inside that condition—including nested conditions—when you cut, copy, or 

paste.

Where to create actions

The actions you apply to CourseBuilder interactions can be actions that ship with Adobe Dreamweaver as well as the 

learning-specific actions that ship with CourseBuilder for Dreamweaver. Use either the Dreamweaver Behavior 

inspector or the Action Manager tab of the CourseBuilder interaction dialog box to create actions for CourseBuilder 

interactions.

Whether you use the Behavior inspector or the Action Manager tab determines when an action is called:

• If you use the Behavior inspector, the actions exist entirely outside the CourseBuilder Interaction—even if they 

apply to CourseBuilder Interactions on the page. Actions are called from an event in HTML or JavaScript.

• If you use the Action Manager tab, the actions exist entirely inside a CourseBuilder Interaction. Actions are called 

from the Action Manager.

Use the Behavior inspector to execute actions on any event on an HTML page, including some events that affect a 

specific CourseBuilder Interaction. For example, you could set the Control Sound action to execute on the onFocus 

event as soon as a user clicks inside the text entry field of a text entry CourseBuilder interaction.
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Use the Action Manager tab to execute actions that occur on specific events defined within a CourseBuilder 

Interaction—when a specific drag item is dropped on a specific target within a drag-and-drop CourseBuilder 

interaction, for example. The Action Manager tab can include both independent actions (which occur whenever the 

object is judged, regardless of the state the object is in) and condition-dependent actions (which occur only when 

certain conditions set for the object are met). The Action Manager tab can also be used to set conditions and actions 

for more than one interaction—or for an entire page.

Learning-specific actions

A behavior is a combination of events and actions. When you create a behavior, you specify an event that triggers an 

action. You can associate several actions with a single event.

Actions can be triggered in several ways:

• When the user clicks a button

• When the user clicks a choice

• By an event in the Action Manager

• By an event on a timeline

Learning actions

Judge Interaction

The Judge Interaction action evaluates the list of statements in the Action Manager tab for the CourseBuilder 

Interaction and can execute actions based on the results.

The Judge Interaction action allows you to choose which interaction or event triggers the Action Manager, channeling 

the flow of control.

To add a Judge Interaction action:

1 Attach a behavior to a CourseBuilder Interaction or add an action to the Action Manager.

2 In the Judge Interaction dialog box, choose the CourseBuilder Interaction that you want to judge from the 

Interaction pop-up menu.

You can set up the button to judge several CourseBuilder Interactions by adding additional Judge Interaction 

actions and specifying each intended interaction.

Reset Interaction

The Reset Interaction action clears user input during the interaction. This action primarily controls the visual elements 

of the interaction. Use the Reset Interaction action to reset elements of drag-and-drop interactions, as well as swapped 

images.

This action can apply to:

• The entire object interaction

• Elements within an object interaction or individual drag-and-drop elements

• Action Manager segments that track state transitions
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Reset Interaction does not reenable items that have been disabled. To reenable an item, use the Set Interaction 

Properties action in the Action Manager.

Radio buttons are an exception to the Reset Interaction action: they are not cleared.

To add a Reset Interaction action:

1 In the CourseBuilder Interaction dialog box, click the General tab.

2 In the General tab, deselect "Create a Reset button for this Interaction".

3 In the Action Manager tab, select the segment, condition, or action you want the Reset Interaction action to follow.

4 Select Reset Interaction from the pop-up menu, and click Add.

5 In the Reset Interaction dialog box, select Entire Interaction from the Reset pop-up menu.

6 In the Interaction pop-up menu, select the CourseBuilder Interaction you want to reset.

To reset interaction elements:

Only the drag-and-drop CourseBuilder Interactions have elements that you can reset individually.

1 On the General tab, deselect "Create a Reset button for this Interaction".

2 On the Action Manager tab, select the segment, condition, or action you want the Reset Interaction action to follow.

3 Select Reset Interaction from the pop-up menu, and click Add.

4 In the Reset Interaction dialog box, in the Reset pop-up, select "Elements only".

5 From the Interaction pop-up menu, select the CourseBuilder Interaction that contains the elements you want to 

reset.

6 Choose an element from the Element pop-up menu.

7 Click OK to close the Reset Interaction dialog box.

Reset the Action Manager:

You can reset the entire Action Manager or individual segments that track state transitions.

1 On the Action Manager tab, select the segment, condition, or action you want the Reset Interaction action to follow.

2 Select Reset Interaction from the pop-up menu, and click Add.

3 In the Reset Interaction dialog box, in the Reset pop-up menu, select "Action Manager only".

4 From the Interaction pop-up menu, select the CourseBuilder Interaction that contains the Action Manager you 

want to reset.

5 Choose a segment from the Segment pop-up menu.

6 Click OK to close the Reset Interaction dialog box.

Set Interaction Properties

The Set Interaction Properties action is the key to fine-tuning your interaction, allowing you to dynamically change 

properties you have already set in the CourseBuilder Interaction dialog box. There are three types of properties: 

Interaction, Action Manager, and JavaScript.

Popup Message

The Popup Message action displays a JavaScript alert dialog box with the message you specify. Because JavaScript alert 

dialog boxes have only one button (OK), use this action to provide information, not to present the user with a choice.
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You can embed any valid JavaScript function call, property, global variable, or other expression in the text. To embed 

a JavaScript expression, place it inside braces ({}). To display a brace as part of the text, precede it with a backslash, as 

follows: \{.

Add a Popup Message action:

1 In the CourseBuilder document, select the CourseBuilder Interaction for which you are creating the feedback.

2 In the CourseBuilder Interaction Property inspector, click Edit.

3 In the CourseBuilder Interaction dialog box, click the Action Manager tab.

4 Select the segment, condition, or action that the Popup Message action will follow.

5 Choose Popup Message from the Action Manager pop-up menu, then click Add.

6 In the Popup Message dialog box, enter a message in the Message field; then click OK.

Set Text of Frame

The Set Text of Frame action replaces the content and formatting of a frame with the content you specify. The content 

can include any valid HTML. Use this action to dynamically display information.

Although the Set Text of Frame action replaces the formatting of a frame, you can select Preserve Background Color 

to preserve the page background and text color attributes.

You can embed any valid JavaScript function call, property, global variable, or other expression in the text. To embed 

a JavaScript expression, place it inside braces ({}). To display a brace as part of the text, precede it with a backslash, as 

follows: \{.

For more information on CourseBuilder Interaction variables, see “JavaScript variables for tracking performance” on 

page 111.

Create a frameset:

1 Do one of the following to create a frameset:

• Choose Modify > Frameset > Split Frame Left, Right, Up, or Down.

• In the Objects panel, in the Frames category, select a predefined frameset.

2 Name the frame so you can identify it as the frame to set text to.

To add a Set Text of Frame action:

1 In the CourseBuilder document, select the CourseBuilder Interaction for which you are creating the feedback.

2 In the CourseBuilder Interaction Property inspector, click Edit.

3 In the CourseBuilder Interaction dialog box, click the Action Manager tab.

4 Select the segment, condition, or action the Set Text of Frame action will follow.

Example You got {G01.totalCorrect} out of {G01.possCorrect}.

Your score is {G01.score}!

The URL for this page is {window.location}, and today is {new Date()}.

Example You got {G01.totalCorrect} out of {G01.possCorrect}.

Your score is {G01.score}!

The URL for this page is {window.location}, and today is {new Date()}.
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5 Choose Set Text of Frame from the Action Manager pop-up menu, then click Add.

6 In the Set Text of Frame dialog box, in the Target pop-up menu, select the target frame.

7 Click the Get Current HTML button to copy the frame HTML content and formatting.

8 Enter a message in the New HTML field, then click OK.

Set Text of Layer

The Set Text of Container action replaces the content and formatting of a DIV with the content you specify. The 

content can include any valid HTML.

Set Text of Container replaces the content and formatting of the DIV, but retains DIV attributes, including color. 

Format the content by including HTML tags in the text field.

You can embed any valid JavaScript function call, property, global variable, or other expression in the text. To embed 

a JavaScript expression, place it inside braces ({}). To display a brace as part of the text, precede it with a backslash, as 

follows: \{.

For more information on CourseBuilder Interaction variables, see “JavaScript variables for tracking performance” on 

page 111.

Create a DIV:

1 Click Insert panel > Common > Insert DIV tag.

For more information on creating DIVs, see "Creating DIVs" in the DreamWeaver documentation.

2 Decide which DIV to write to.

To add a Set Text of Container action:

1 In the CourseBuilder document, select the CourseBuilder Interaction for which you are creating the feedback.

2 In the CourseBuilder Interaction Property inspector, click Edit.

3 In the CourseBuilder Interaction dialog box, click the Action Manager tab.

4 Select the segment, condition, or action that the Set Text of Container action will follow.

5 Choose Set Text of Container from the Action Manager pop-up menu, then click Add.

6 In the Set Text of Container dialog box, select the target DIV from the Container menu.

7 Enter a message in the New HTML field, then click OK.

Set Text of Text Field

The Set Text of Text Field action replaces the content of a form text field with the content you specify. Use this action 

to dynamically display information.

You can embed any valid JavaScript function call, property, global variable, or other expression in the text. To embed 

a JavaScript expression, place it inside braces ({}). To display a brace as part of the text, precede it with a backslash, as 

follows: \{.

Example You got {G01.totalCorrect} out of{G01.possCorrect}.

Your score is {G01.score}!

The URL for this page is {window.location}, and today is {new Date()}.
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For more information on CourseBuilder Interaction variables, see “JavaScript variables for tracking performance” on 

page 111.

Create a named text field:

1 Choose Insert > Form Object > Text Field.

For more information, see "Creating forms" in the Dreamweaver documentation.

2 Name the text field.

To add a Set Text of Text Field action:

1 In the CourseBuilder document, select the CourseBuilder Interaction for which you are creating the feedback.

2 In the CourseBuilder Interaction Property inspector, click Edit.

3 In the CourseBuilder Interaction dialog box, click the Action Manager tab.

4 Select the segment, condition, or action that the Set Text of Text Field action will follow.

5 Choose Set Text of Text Field from the Action Manager pop-up menu, then click Add.

6 In the Set Text of Text Field dialog box, in the Text Field pop-up menu, select the text field you want the text to 

display in.

7 In the New Text field, type the text you want displayed, then click OK to close the Set Text of Text Field dialog box.

Common actions

Send Interaction Info

Send Interaction Info passes information about a single CourseBuilder Interaction to a CMI application. Send 

Interaction Info customizes the information sent by the default tracking.

To add a Send Interaction Info action:

1 In the Action Manager tab, select the statement that you want to trigger the Send Interaction Info action.

2 Select Send Interaction Info from the Action Manager pop-up menu, and click Add.

The Send Interaction Info dialog box appears.

3 Type in optional Interaction and Objective IDs.

4 Choose an Interaction type from the Interaction Type pop-up menu.

5 Type the appropriate information in the following fields: List Correct Responses, List Student Responses, List 

Results, Weight, and Latency.

6 Click OK.

Send Lesson Time

Send Lesson Time passes information about how long the user took to complete a lesson, or group of interactions, to 

a CMI application.

Example You got {G01.totalCorrect} out of {G01.possCorrect}.

Your score is {G01.score}!

The URL for this page is {window.location}, and today is {new Date()}.
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To add a Send Lesson Time action:

1 In the Action Manager tab, select the statement that you want to trigger the Send Lesson Time action.

2 Select Send Lesson Time from the Action Manager pop-up menu, and click Add.

3 In the Send Lesson Time dialog box, choose the CourseBuilder Interaction for which you are sending the score from 

the Interaction pop-up list.

To override the lesson time that was previously associated with the element, choose <custom> from the Interaction 

pop-up list and type a new lesson time in the Lesson Time field.

4 Click OK.

Send Objective Info

Send Objective Info passes information about the object or lesson objective, as defined in the Tracking tab of the 

CourseBuilder Interaction dialog box, to a CMI application. 

To add a Send Objective Info action:

1 In the Action Manager tab, select the statement that you want to trigger the Send Objective Info action.

2 Select Send Objective Info from the Action Manager pop-up menu and click Add.

3 In the Send Objective Info dialog box, choose the CourseBuilder Interaction for which you are sending the objective 

ID from the Interaction pop-up menu.

To override the objective ID, score, and lesson status that you previously associated with the element on the 

Tracking tab:

• Choose <custom> from the Interaction pop-up menu and type a new objective ID in the Objective ID field.

• Type an objective score in the Score field.

• Choose an objective lesson status from the Lesson Status pop-up menu.

4 Click OK to close the Send Objective Info dialog box.

Send Core Data

Send Core Data passes information about the lesson location, lesson status, user score, and time to a CMI application.

To add a Send Core Data action:

1 In the Action Manager tab, select the statement that you want to trigger the Send Core Data action.

2 Select Send Core Data from the Action Manager pop-up menu, and click Add.

3 In the Send Core Data dialog box, enter values for lesson location, lesson status, user score, and time.

4 Click OK.

AICC/SCORM 1.2 actions

Send Lesson Status

Send Lesson Status passes information about the status of a lesson, or group of interactions, to a CMI application.

To add a Send Lesson Status action:

1 In the Action Manager tab, select the statement that you want to trigger the Send Lesson Status action.

2 Select Send Lesson Status from the Action Manager pop-up menu, and click Add.
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3 In the Send Lesson Status dialog box, choose the lesson status from the Lesson Status pop-up menu.

Choices in the Lesson Status pop-up menu are as follows:

Passed indicates that the user has achieved whatever parameters have been established as passing.

Completed indicates that the user has finished the activity.

Failed indicates that the user has not achieved whatever parameters have been established as passing.

Incomplete indicates that the user has started but not finished the activity.

Browsed indicates that the user has accessed the pages but not necessarily completed the activity.

Not attempted indicates that the user has not accessed the pages of the activity.

4 Click OK.

Send Score

Send Score passes information about the user's score for a single CourseBuilder Interaction or for a lesson (a group of 

CourseBuilder Interactions) to a CMI application.

To add a Send Score action:

1 In the Action Manager tab, select the statement that you want to trigger the Send Score action.

2 Select Send Score from the Action Manager pop-up menu, and click Add.

3 In the Send Score dialog box, choose the CourseBuilder Interaction for which you are sending the score from the 

Interaction pop-up menu.

To override the score you previously associated with the element in the CourseBuilder Interaction dialog box's 

score field, choose <custom> from the Interaction pop-up list and type a new score in the Score field.

4 Click OK.

Send GetParam

Send GetParam sends a request for information about the user to the tracking system. The information returned is not 

available to CourseBuilder, but provides compliance with AICC standards and compatibility with various CMI 

vendors.

To add a Send GetParam action:

1 In the Action Manager tab, select the statement that you want to trigger the Send GetParam action.

2 Select Send GetParam from the Action Manager pop-up menu, and click Add.

3 Click OK.

Knowledge Track actions

The actions associated with Knowledge Track can be linked with an event in the browser or a condition or command 

in the Action Manager. The following steps are important to enable the Knowledge Track actions.

1 In the General tab of the CourseBuilder Interaction dialog box, select Knowledge Track.

The Tracking tab appears to the right of the General tab.

2 Click the Tracking tab and define the interaction ID, objective ID, and weight for the entire object interaction.

Interaction ID assigns a unique value to the interaction. This value can be accessed through JavaScript or the CMI 

system.
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Objective ID assigns an objective ID to the CourseBuilder Interaction. Each CourseBuilder Interaction can be tied 

to a specific learning objective as defined by the content author.

Weight defines the relative importance of the CourseBuilder Interaction's scoring within the overall group of 

interactions of which it is part. The CMI server uses the weight to calculate a score for the entire course.

Knowledge Track does not record an actual score for individual object interactions. Use the “Send Score” on page 98 

action in the Action Manager to define how objects (or groups of objects) are scored.

Selecting the Knowledge Track option sends the user response information to the server—including correct responses 

defined for the object, the user's actual response and if it was correct, and when and how long it took the user to 

complete the interaction.

For more information about using Knowledge Track actions, see“Tracking user performance” on page 109.

Setting interaction properties

The Set Interaction Properties action is the key to fine-tuning your interaction, allowing you to dynamically change 

properties you have already set in the CourseBuilder Interaction dialog box. Using the Set Interaction Properties 

action, you can override a previously set property to respond to a certain condition. For example, use this action with 

the Disabled property to disable a question after the time limit expires.

You can set up the Set Interaction Properties action to be triggered:

• When the user clicks a button

• When the user clicks a choice

• When play back reaches a specific frame on the timeline

• By an event you specify in the Action Manager

There are three types of properties: Interaction, Action Manager, and JavaScript. CourseBuilder Interaction properties 

can affect the entire interaction, such as resetting the score, or they can affect a single element of the interaction, such 

as resetting correctness. Action Manager properties affect the entire Action Manager or specified segments. The 

JavaScript property allows you to write JavaScript expressions—or just to examine the underlying JavaScript.

Setting properties of CourseBuilder Interactions

To choose the CourseBuilder Interaction and the property you want to set:

1 Attach a behavior to an object or add an action to the Action Manager.

2 In the Set Interaction Properties dialog box, from the Set pop-up menu, choose Interaction.

3 From the Interaction pop-up menu, choose the CourseBuilder Interaction you want to set a property for:

To set property for the entire interaction, choose <none> from the menu to the right.

To set a property for an element of the interaction, choose the element from the menu to the right.

4 From the Property pop-up menu, choose the property you want to set.

5 Set the property:

To set a Boolean property using a constant:

Choose True/False from the Type pop-up menu; then choose True or False from the Value pop-up menu.

To set a numeric property using a constant:
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Choose Number from the Type pop-up menu; then enter a number in the Number field.

To set a text property using a constant:

Choose Text from the Type pop-up menu; then enter a text string in the Text field.

To set a property using JavaScript:

Choose JavaScript from the Type pop-up menu; then enter an expression in the JavaScript field.

To set the Correct State property:

Choose Select from the Type pop-up menu; then choose Not Judged, Correct, or Incorrect from the Value pop-up menu.

CourseBuilder Interaction properties

You can apply many interaction properties either to an entire interaction or to an individual element of an interaction. 

Some properties, however, apply only to interaction elements. Properties limited to elements are noted here.

Alignment

All That Apply

Allow Multiple Selections

Correctness

Type Select list

Description Where, in relation to the target, the drag object snaps. Choose from: center, left, right, top, bottom, or top left. 

Applies only to drag-and-drop CourseBuilder Interaction element property.

Type Boolean

Description TRUE. The user has to select all of the correct answers for the CourseBuilder Interaction to be judged correct.

FALSE. The user can select any correct answer for the CourseBuilder Interaction to be judged correct.

The CourseBuilder Interaction must be reset or interacted with before the Correctness property of the 

CourseBuilder Interaction reflect this setting.

Type Boolean

Description TRUE. Can select multiple choices in the CourseBuilder Interaction.

FALSE. Can only select one choice in a given try.

Allow Multiple Selections has no effect on radio buttons.

Type Select list

Description Choose correct, incorrect, or not judged to indicate how the Action Manager evaluates a choice. Setting 

Correctness does not update Possible Correct or Total Elements. Update them manually and reset the 

CourseBuilder Interaction. CourseBuilder Interaction element property only.
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Correct State

Disabled

Expected Value

Initial Value

Is Toggle

Judge On Selection

Type Select list

Description Sets the correct state of the entire CourseBuilder Interaction, overriding individual judging.

The Correct State property is reset every time the CourseBuilder Interaction is touched, and so the set 

property is valid only with the current flow of action.

Type Boolean

Description TRUE. The choice designated is disabled.

FALSE. The choice designated is enabled.

Type Select list, True/False, Text, Number

Description The Expected Value is compared to the Value property that a user enters to determine if this choice is 

designated as selected. For example in a text entry CourseBuilder Interaction, if the Expected Value is 

the text string "Red" and the value that the user input is "Red," then Selected is true. CourseBuilder 

Interaction element property only.

Type Select list, True/False, Text, Number

Description The Initial Value indicates what the choice value is set to before the user makes a choice. If you change 

the value, reset the CourseBuilder Interaction before the change is reflected in the element. 

CourseBuilder Interaction element property only.

Type Boolean

Description TRUE. The button element works like a toggle switch.

FALSE. The button element works like a push button.

Button CourseBuilder Interaction element property only.

Type Boolean

Description TRUE. Triggers the Action Manager to evaluate the conditions when the item is selected.

FALSE. Allows some other event to trigger the evaluation of the conditions in the Action Manager.



102USING ADOBE ELEARNING SUITE COURSEBUILDER EXTENSION

Action Manager

Last updated 4/1/2011

Knowledge Track

Known Response

Match Case

Match Entire Word

Original X Position

Original Y Position

Type Boolean

Description TRUE. Sends tracking information to a computer-managed instruction (CMI) application. Select the 

Knowledge Track option on the General tab in the CourseBuilder Interaction dialog box for this to work.

FALSE. Disables the sending of itemization data to the CMI application. Actions that send progress 

data, such as Send Score, can still send data.

Type Boolean

Description TRUE. A response has been selected.

FALSE. A response has not been selected.

The Known Response property is reset when the user selects a choice.

Type Boolean

Description TRUE. The text entry input must match the case of the expected answer to be judged correct.

FALSE. The text entry input need not match the case of the expected answer to be judged correct.

You must reset the CourseBuilder Interaction or the CourseBuilder Interaction must be touched for this 

to take effect. Text entry CourseBuilder Interaction element property only.

Type Boolean

Description TRUE. The text entry input must match the entire word of the expected answer to be judged correct.

FALSE. The text entry input does not need to match the entire word of the expected answer to be judged 

correct.

You must reset the CourseBuilder Interaction or the CourseBuilder Interaction must be touched for this to 

take effect. Text entry CourseBuilder Interaction element property only.

Type Numeric

Description The original x-axis position of the drag element. This is the x position the drag element is set to if it's reset. 

Drag-and-drop CourseBuilder Interaction element property only.

Type Numeric

Description The original y-axis position of the drag element. This is the y position the drag element is set to if it's 

reset. Drag-and-drop CourseBuilder Interaction element property only.
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Possible Correct

Possible Incorrect

Score

Selected

Snap Back on Incorrect

Snap Back on Miss

Type Numeric

Description The number of possible correct choices for the CourseBuilder Interaction. If you've set the All That 

Apply property to true, changing the Possible Correct property affects whether a CourseBuilder 

Interaction is judged correct or incorrect. You must reset the CourseBuilder Interaction or the 

CourseBuilder Interaction must be touched for this to take effect.

Type Numeric

Description The number of possible incorrect choices for the CourseBuilder Interaction. Changing the Possible 

Incorrect property doesn't affect the judging of a CourseBuilder Interaction.

Type Numeric

Description The designated numeric score for the CourseBuilder Interaction. A possible use for the Score action 

is granting bonus points to a CourseBuilder Interaction under certain conditions. The Score property 

resets when the user makes a selection.

Type Boolean

Description TRUE. The element is selected.

FALSE. The element is unselected.

CourseBuilder Interaction element property only.

Type Boolean

Description TRUE. The drag element snaps back to the starting point when an incorrect target is hit.

FALSE. The drag element doesn't snap to the starting point when an incorrect target is hit.

The Action Manager is not evaluated when the drag element snaps back. Drag-and-drop 

CourseBuilder Interaction element property only.

Type Boolean

Description TRUE. The drag element snaps back to the starting point if no target is hit.

FALSE. The drag element doesn't snap back to the starting point if no target is hit.

The Action Manager is not evaluated when the drag element snaps back. Drag-and-drop 

CourseBuilder Interaction element property only.
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Snaps to

Time

Time Limit

Tolerance

Total Correct

Total Elements

Total Incorrect

Type Boolean

Description TRUE. The drag object snaps to the target object.

FALSE. The drag object does not snap to the target object.

Drag-and-drop CourseBuilder Interaction pair property only.

Type Numeric

Description The time, measured in seconds, that the user spends in the CourseBuilder Interaction.

Type Numeric

Description The number of seconds allocated as the time limit of a CourseBuilder Interaction.

Type Numeric

Description The area around a target, measured in pixels, that causes the drag object to snap to the target 

object. Use the Tolerance property to increase or decrease the drop area of a drag-and-drop 

interaction. Drag-and-drop CourseBuilder Interaction pair property only.

Type Numeric

Description The total number of correct choices for a CourseBuilder Interaction.

This property is reset when the user selects a choice.

Type Numeric

Description The total number of elements in a CourseBuilder Interaction. For example, the number of choices in 

a multiple-choice question.

Type Numeric

Description The total number of incorrect choices for a CourseBuilder Interaction.

This property is reset when the user selects a choice.
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Tracking Interaction ID

Tracking Objective ID

Tracking Question Type

Tracking Weight

Tries

Tries Limit

Unknown Correctness

Type Text

Description The tracking interaction ID for the interaction.

Type Text

Description The tracking objective ID for the interaction.

Type Text

Description The tracking question type for the interaction.

Type Numeric

Description The tracking weight for the interaction.

Type Numeric

Description The number of tries the user has taken in the interaction. Remember, a try is equivalent to a 

single evaluation of the Action Manager.

Type Numeric

Description The number of times a user can try the interaction. Use the Tries Limit property to allow users to try the 

interaction more than one time under certain conditions.

This property is reset when the user selects a choice.

Type Select list

Description The default correctness value the Action Manager uses if the user doesn't select any response for the 

interaction. Once the page is loaded, changing this property has no effect until the interaction is reset.
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Value

X Offset

Y Offset

Setting Action Manager properties

Action Manager properties can apply to the entire interaction or to any of the segments in an interaction.

To set an Action Manager property:

1 Attach a Set Interaction Properties behavior to an object or add an action to the Action Manager.

2 In the Set Interaction Properties dialog box, from the Set pop-up menu, choose Interaction.

3 From the Interaction pop-up menu, choose the CourseBuilder Interaction you want to set a property for. From the 

pop-up menu to the right, choose <none> to affect the entire Action Manager or select one of the segments from 

the Segment pop-up menu.

4 From the Property pop-up menu, choose either “Current Node” on page 106 or “Disabled” on page 107.

Current Node

Type Select list

Description Sets the value for the specified element. For example, in a text field, the value is the text; for a multiple-

choice element, it's true or false depending on whether the choice has been selected or not; and for a 

timer, it's the current time displayed. CourseBuilder Interaction element property only.

Type Numeric

Description The number of pixels added to or subtracted from the drag-and-drop snap-to location. Use X Offset to fine-

tune the alignment of the snap-to location. Drag-and-drop CourseBuilder Interaction pair property only.

Type Numeric

Description The number of pixels added to or subtracted from the drag-and-drop snap-to location. Use Y Offset to fine-

tune the alignment of the snap-to location. Drag-and-drop CourseBuilder Interaction pair property only.

Type Select list

Description The starting evaluation point for state transition segments:

• Reset places the current node at the start of the segment

• Done places the current node at the end of the segment, so that the segment will no longer be 

evaluated

The other option is to set Current Node to a specific condition name. This resets the evaluation of a 

state transition segment to a higher node. For example, to create a condition that checks if a user has 

made a mistake, add an action that would give the user some feedback and then set the current node 

back to the condition. The segment is then ready to check if the user makes that same error again.
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Disabled

Setting the JavaScript property

Use the JavaScript property field to customize the setting of a property in a way that is not possible in the standard 

CourseBuilder Interactions user interface. The information that appears in the JavaScript field corresponds with the 

actions and behaviors that have been set. This field is a good way to understand the scripting behind the actions and 

behaviors that CourseBuilder for Dreamweaver creates.

To set the JavaScript property:

1 Attach a CourseBuilder Interaction property behavior to an object or add an action to the Action Manager.

2 In the Set Interaction Properties dialog box, choose JavaScript from the Set pop-up menu.

3 Enter a JavaScript expression in the field provided.

Adding a custom behavior

The list of behaviors in the Action Manager is dynamically generated, making it easy to use custom behaviors.

To add a custom behavior:

1 Create your custom behavior.

2 Copy the JavaScript and HTML files to Dreamweaver CS5\Configuration\Behaviors\Actions.

The new behavior appears at the bottom of the Action Manager pop-up menu and in the Behavior window.

Action Manager CourseBuilder Interactions

The Action Manager object stores information from and controls all or a group of CourseBuilder Interactions on a 

page. Unlike other CourseBuilder Interactions, the Action Manager object does not have its own interactivity and is 

invisible to users.

Use an Action Manager CourseBuilder Interaction to collect results from a set of multiple-choice questions, 

summarize these results, and send a score back to a tracking system. You can use Action Manager CourseBuilder 

Interactions to take advantage of existing interactions on a page while creating a wide variety of system actions. You 

can also use several Action Manager CourseBuilder Interactions on a page and have each object behave differently.

For example, one Action Manager CourseBuilder Interaction could set properties on interactions and trigger actions 

that make the page act as if it were a tutorial. After those actions executed, the Action Manager CourseBuilder 

Interaction could enable another Action Manager CourseBuilder Interaction on the same page to control the 

interactions on the page to simulate the correct responses to that tutorial. A third Action Manager CourseBuilder 

Interaction could enable the second Action Manager CourseBuilder Interaction to control the simulation while the 

third CourseBuilder Interaction collected results and sent those results to a CMI system.

Type Boolean

Description TRUE. The Action Manager or segment is disabled.

FALSE. The Action Manager or segment is enabled.
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An Action Manager object's segments can apply to any or all CourseBuilder Interactions on that HTML page.

Do not confuse the Action Manager CourseBuilder Interaction, which defines the actions of multiple CourseBuilder 

Interactions on a single HTML page, with the Action Manager tab, which defines the conditions and actions for a 

single CourseBuilder Interaction.

The Action Manager template

Click the Action Manager template icon, and then use the tabs of the CourseBuilder Interaction dialog box to 

customize the Action Manager:

ActionMgr manages a group of object interactions on a page but does not appear on-screen.

The Action Manager CourseBuilder Interaction options

General tab

Tracking tab

The Tracking tab appears only if you have selected the Knowledge Track option on the General tab.

Action Manager tab

The Action Manager tab is where you add code segments that define how the CourseBuilder Interaction behaves under 

specific conditions.

Field Description

Interaction Name Unique name of the interaction used to identify the CourseBuilder Interaction in the Condition Editor and other 

dialog boxes.

Judge 

Interaction

Determines when CourseBuilder for Dreamweaver evaluates a user's response.

Knowledge Track Sends information about a user's performance to a computer-managed instruction system.

Tries Are Limits the number of tries a user has to respond to the interaction.

Time Is Limits the amount of time a user has to respond to the interaction. 

DIV Places the entire CourseBuilder Interaction in an AP DIV. 
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Chapter 14: Scoring and Data Tracking

Tracking user performance

Scoring and data tracking are key functions for evaluating how well users perform. Tracking users' performance has 

several benefits:

• Provides feedback to users as they work through the course

• Gets feedback from users while you develop and test a piece

• On course completion, assesses how well users have done

• Uses performance information to design a more effective training piece

CourseBuilder for Adobe Dreamweaver makes tracking performance easy. Use CourseBuilder Interaction settings to 

mark a response right or wrong, and to apply a score to a response. You can also use JavaScript with CourseBuilder 

Interaction variables to get dynamic information about the user's interactions.

The Knowledge Track feature allows you to exchange standard student performance information with computer-

managed instruction (CMI) systems.

Knowledge Track keeps track of:

• The number of right and wrong target responses a user has made

• The number of tries the user took to get the right answer

• The amount of time it took the user to respond to an interaction

• The amount of time the user spent in an interaction

• The amount of time remaining if there was a time limit on an interaction

• The score for an interaction

You can transfer information directly to CMI systems using CourseBuilder for Dreamweaver's Knowledge Track 

actions—or save the information in a database, such as Microsoft Access, SQL Server, or Oracle.

Consider the following if you want to track and record the user's performance:

• What activities do you need to track to assess a user's performance?

• What level of performance is acceptable?

• How you will use the information you gather? Will you use it to provide feedback? Will you display the information 

on the screen to the user?

• Where will you store performance information? On a local server? On a web server across the Internet?

• Do you want to store the information you gather in a CMI system?

Marking a response right or wrong

CourseBuilder for Adobe Dreamweaver elements has three judge values—Correct, Incorrect, or Not Judged. The 

responses and their values are stored in a special set of system variables. This information is then available to provide 

feedback to users as they respond to the interaction, and to pass along to a CMI system.
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Select one of the following settings to mark a response:

Correct marks a response right.

Incorrect marks a response wrong.

Not Judged marks a response as neither right nor wrong.

Scoring a response

Use the Score option to add a score to each response in an interaction. Use positive values for correct responses and 

negative values for incorrect ones. Use higher values for more accurate answers and lower values for answers that are 

correct, but not complete.

The CourseBuilder Interaction adds up the scores of responses in interactions—such as all-that-apply questions and 

drag-and-drop matching exercises—that have more than one correct answer. The CourseBuilder Interaction does not, 

however, produce a cumulative score if you give users more than one try to respond to an interaction correctly.

Displaying feedback

You can display feedback messages using the following actions:

Add interaction-specific information to feedback messages with JavaScript variables. Enclose the CourseBuilder 

Interaction's unique ID and the variable in braces ({}). For example, you can use the following text with a Popup 

Message, Set Text of Frame, Set Text of Container, or Set Text of Text Field action:

You got {G01.score--} points in this exercise.

The value of the CourseBuilder Interaction's score variable replaces the text between the braces:

You got 97 points in this exercise.

Locating the CourseBuilder Interaction identifier in 
HTML Source code

Every CourseBuilder Interaction on an HTML page has a unique identifier that begins with the letter G followed by a 

number.

To see a CourseBuilder Interaction's unique identifier:

1 Click the CourseBuilder Interaction icon on the page to select the object.

Action Name What it does

Popup Message Displays feedback in a pop-up dialog box. This is the default feedback setting.

Set Text of Frame Displays feedback in a different frame on the web browser.

Set Text of Container Displays feedback in a DIV on the page.

Set Text of Text Field Displays feedback in a text field within a form on the page.



111USING ADOBE ELEARNING SUITE COURSEBUILDER EXTENSION

Scoring and Data Tracking

Last updated 4/1/2011

2 Choose Window > HTML to view the source for the page.

The first highlighted line in the HTML window contains the selected CourseBuilder Interaction's unique identifier. 

In this example, the CourseBuilder Interaction's unique ID is G01 (that's a zero after the letter G):

object="G01"

See “JavaScript variables for tracking performance” on page 111 for more information about CourseBuilder 

Interaction variables.

Scoring and tracking

Scoring multiple interactions on the same HTML page

You can combine several CourseBuilder Interactions on the same HTML page to create a timed self-assessment quiz. 

“Scoring multiple interactions on different HTML pages” on page 111 shows how to store information about multiple 

CourseBuilder Interactions when each CourseBuilder Interaction occupies its own HTML page.

Scoring multiple interactions on different HTML pages

CourseBuilder for Adobe Dreamweaver is designed for compatibility with server-side software and other computer-

managed instruction (CMI) systems that follow AICC web standards. Such systems allow a great deal of functionality 

for deploying and tracking web-based applications.

You can develop effective applications with CourseBuilder for Dreamweaver without CMI or other server-side 

software.

Tracking the time remaining

Use a timer CourseBuilder Interaction to show a visual image of the time remaining in a timed activity. You can also 

use an Action Manager CourseBuilder Interaction to track the time remaining without showing a visual display. See 

“Scoring multiple interactions on the same HTML page” on page 111 for an example.

Tracking the number of tries

Set a fixed limit on the number of tries that a user is allowed to correctly respond to an interaction. Or use the tries 

JavaScript variable to track the number of attempts that the user has made. See “JavaScript variables for tracking 

performance” on page 111 for more information.

JavaScript variables for tracking performance

The following JavaScript variables can be used to track the performance and provide feedback. The syntax for all the 

variables is:

var myVar = G01.variablename

For example:

var myScore = G01.score + G02.score + G03.score + G04.score

Display the value of these variables in feedback messages by enclosing the CourseBuilder Interaction's unique ID and 

the variable in braces ({}). For example, you can type the following text for the Popup Message, Set Text of Frame, Set 

Text of Container, and Set Text of Text Field actions:
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You got {G01.totalCorrect} out of {G01.possCorrect}!

Recording performance

CourseBuilder for Dreamweaver automatically keeps track of information about a user's performance. However, the 

CourseBuilder Interactions do not store this information indefinitely, and they do not save the information 

permanently before the student exits the HTML page.

To keep the information permanently, record it with a computer-managed instruction (CMI) system or server-side 

database.

A web site created with CourseBuilder for Dreamweaver, when linked to a server-side database, becomes a powerful 

medium for generating customized interactive pages for anyone with a web browser. CourseBuilder for Dreamweaver 

can be used to collect information about the site visitor's interactions, and to transfer that information to the database 

for tracking and recording.

Using Knowledge Track

Select the Knowledge Track option on the General tab to use Knowledge Track.

The Knowledge Track feature is designed to transfer data to a server running computer-managed instruction (CMI) 

software that complies with the AICC standard, SCORM 1.2 and SCORM 2.0 standards (for information visit the 

AICCand SCORM websites.

The Tracking tab contains settings to specify interaction properties that are recorded by a CMI or database server 

application. See “Tracking tab” on page 31.

Variable Name Purpose

score Contains the numeric score for the interaction.

totalCorrect Contains the total number of correct responses the user made in the interaction.

totalIncorrect Contains the total number of incorrect responses the user made in the interaction.

possCorrect Contains the total number of correct responses to the interaction.

possIncorrect Contains the total number of incorrect responses to the interaction.

correct Is true if the student completed the interaction correctly, false otherwise.

tries Contains the number of times the user matched a response in the interaction.

triesLimit Contains the number of attempts that the user is allowed to enter a correct response in the 

interaction.

time Contains the amount of time in HH:MM:SS format that has elapsed since the interaction was 

last judged.

timeLimit Contains the amount of time in HH:MM:SS format that the user is allowed to enter a correct 

response in the interaction.

trackIntId Contains the Interaction ID string entered in the Tracking tab of the CourseBuilder 

Interaction.

trackObjectiveId Contains the Objective ID string entered in the Tracking tab of the CourseBuilder Interaction.

trackQType Contains a string to identify the type of interaction.

trackWeight Contains the Weight value entered in the Tracking tab of the CourseBuilder Interaction.

http://www.aicc.org/
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When you select Knowledge Track, the following information is automatically sent to the CMI server every time the 

CourseBuilder Interaction is judged:

• The current date (DD/MM/YYYY)

• The current time (HH:MM:SS)

• The string entered in the Interaction ID field of the Tracking tab

• The string entered in the Objective ID field of the Tracking tab

• The type of the interaction

• The correct answers for the CourseBuilder Interaction

• The answer given by the student

• Whether the student's response was correct or incorrect

• The weight given to the question for scoring

• The time it took for the student to answer the question (HH:MM:SS)

When Knowledge Track is enabled, you can also use the following tracking actions in a CourseBuilder Interaction's 

Action Manager to communicate with the CMI system:

Action What it does

Send Score Sends the activity score to the CMI system

Send Lesson Status Sets the activity's status as passed, failed, completed, or started

Send Lesson Time Sends the amount of time the student spent in the activity

Send Objective Information Sends information about the activity's specified objective

Send Interaction Information Sends information about a specific interaction

Send Core Data Sends [core] data group, to comply with AICC standards

Send GetParam Sends GetParam action, to comply with AICC standards
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